
 
 Flash Cs4آمٌزش

 مقدماتي 
 
 

92بهار   
 آمىزشگاه اسپيرال
 مهندس كريمي
 

:نشانی وبلاگ مهندس کريمی  

Http://Hardwarecom86.blogfa.com 

Http://Karimionline.uni.me 

:نشانی وبلاگ آمىزشگاه   

Http://Spiralschool.persianblog.ir 

 

 

http://hardwarecom86.blogfa.com/
http://karimionline.uni.me/
http://spiralschool.persianblog.ir/


Flash Cs4 Learning  

 Page 2 آمىزشگاه اسپيرال 
 

  

 :فٍرضت مُضُػی 

 5 پص از وصة

Stage: 5 

 Library : 5پىو 

Timeline: 6 

 Timeline: 6تغيير دادن ظاٌر 

 Properties: 6پىو 

 Tools: 6پىو 

 6 (:Selection tool)اتسار اوتخاب

 7 (:Lasso Tool)اتسارممىذ

 7 (:SubselectionTool)اتسار اوتخاب فرػي 

 7 (:Eraser Tool)اتسار پاك مه

 7 (:Line Tool)اتسار خظ 

 7 :(Brush Tool)اتسار قيمُ

 8 :(Pencil Tool)اتسار مذاد

 8 :(Rectangle Tool)اتسار رضم غنو

 8 :(Deco Tool)اتسار دمُ

 9 :(Bone Tool)اتسار اضتخُان تىذي

 9 :(Pen Tool)اتسار قيم

 9 :(Paint Bucket Tool)اتسار ضطو روگ

 9 :(Eyedropper)اتسار ومُوً ترداري

 9 :(Free Transform)اتسارتغييرغنو

 9 :(Zoom Tool)اتسار رري تيه

 9 :(Hand Tool)اتسار دضت

 9 :(Text Tool)اتسار تايپ

Static Text: 10 

Dynamic Text 10 

Input : 10 

 Properties: 10در پانل Text ًیژگی ىای

 11 :تخع تىظيمات اتسار

 11 :روگ آميسی در فيع
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 12 :چيذمان اغيا

 13 :(Group)گرَي تىذي 

 13 تراز مردن اغيا

 13 :اوُاع فريم ٌا

 13 :ي دوياي اويميػه ضازيَرَد ب

 13 :اوُاع اويميػه ٌا

 13 تُاىي فريم ٌا -1

2- Motion Tween 14 

 14 :(Graphic Symbols)سمبل گرافیکی

 14 :(Movie clip Symbols)سمبل ىای نمایشی 

 14 :(Button Symbols)سمبل ىای دکمو ای 

 Motion Tween : 15نحٌه ایجاد یك 

 Motion Tween: 15تغییر ًیژگیياي یك 

 Motion Editor: 16آشنایي با پنجره 

 16 وحُي رخيري اويميػه

3-   Classic Tween(ان ياتي ملاضيلمي:) 16 

 Classic Tween: 17تا   Motion Tweenتفاَت ٌاي 

 17 :امکان ايجاد لايً راٌىما 

4- Shape Tween 17 

Shape Tweening  17 :بررًی تصاًیر گرافیکی 

Shape Hint (نقاط کنترلی تغییر شکل اشیاء:) 17 

 18 :کييپ ٌای تُدرتُ ضاخت

 Mask  : 18تُاوايی کار تالايً 

 Rollover 19تکىيک 

 19 :ضاخت دکمً متحرک

 20 :تُزيغ حرَف رَی لايً ٌا

Import: 20 

 20 :َارد کردن ػکص -اىف

 Flash: 20َاردکردن صذادر  -ب 

 20 :آشنایی با خصٌصیات صداىا

 21 :انٌاع جلٌه ىای صٌتی

 21 :تنظیمات ىماىنگ سازی صدا

 21 :تکرار صدا

 21 :افسًدن صدا بو دکمو

 22 : َارد کردن فييم -ج

Export 22 
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 Action Script: 23تُاوايی تکارگيری 

 25 آغىايی تا جؼثً اتسار: پىجم 

 25 :يطی اضتفادي از غی درتروامً وُ

 trace() 25تاتغ کارتردی 

 Action Script : 26ػميگرٌا در 

 26 :ی ءمتغير ظ

 26 تؼريف َفراخُاوی تاتغ

 26 :تؼريف تاتغ ترای کىتره اغيا 

parent  َ ًوقط ،this 27 در فيع 

 27 اضتفادي ار کلاش در فيع

Events  (رَيذادٌا:) 27 

 27 متذ پاضخ دٌی تً رَيذاد

 28 :دريافت دَػذد ازکارتر َومايع حاصيضرب آن

 Action Script: 29کىتره رمس ػثُر تُضظ 

 Action Script: 29َرَد َخرَج کذ ٌا در محيظ 

 30 :وتيجً گيری
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 .اؼآِٛؾ گفتٗ نٛظ ٚگفتٗ ٘ا ِغاتك قؽفًً تانعأي قاظٖ تؽاي نظؼ ايٓ آِٛؾل قؼي نعٖ اقت تا ٔىات لاؾَ ظؼ تي

لعَ اٚي ظؼ آِٛؾل ٘ؽ ٔؽَ افؿاؼ واؼتؽظي ،آنٕايي تا ِسيظ واؼ آْ تؽٔاِٗ ٚ ِٕٛ٘اي آْ ِي تانع تالاضى ،ِٕٛ٘اي واؼتؽظي آْ 
 .ٔيؿ اؾ ايٓ لاػعٖ ِكتثٕا ّٔي تانع flash csٚتؽٔاِٗ 

 پص از وصة 
يفسٗ ضٛل آِعگٛيي ؼا ِيثيٕيع وٗ ظؼآْ ٌيٕه ٘ايي تٗ لاٌة اقتأعاؼظ فايً ،ضٛظآِٛؾ٘ا  تؽاي اٌٚيٓ تاؼ وٗ فٍم ؼا تاؾ وٕيع ،يه

 .ٚظيگؽ ِٕاتغ ٚخٛظ ظاؼظ

 

گؿيٕٗ  Fileاؾ ِٕٛي .تگػاؼيع  Testپٛنٗ اي ؼا ظؼ قيكتُ ايداظ وٕيع ٚ ٔاَ آْ ؼا .اؾ اتتعاي واؼ ضٛظتاْ ؼا تٗ ِٕظُ واؼي ػاظت ظ٘يع 
New  ٓخؽٖ اي وٗ تاؾ ِي نٛظ ؼا أتطاب وٕيع ظؼ پAction Script3  ؼا أتطاب ٚok فٍم تٗ عٛؼ پيم ِسيظ واؼي .ؼا وٍيه وٕيع

.ٚ تؽضي اؾپًٕ ٘اي ظيگؽ ِي تانع Tools،پًٕ  Timeline ،Stageفؽٌ ناًِ ٔٛاؼِٕٛ،

 

ايٓ چيعِاْ ٘ا ظؼ يه ِٕٛ ظؼقّت .فٍم چيعِاْ ٘اي اؾ پيم تؼييٓ نعٖ اي تؽاي پًٕ ٘ا ظاؼظ
ٌيكت نعٖ اقت ٚ ناًِ گؿيٕٗ  Window>workspaceي فضاي واؼي فٍم يا ظؼ ِكيؽؼاقت ٚتالا

تا أتطاب ٘ؽيه اؾ ايٓ چيعِاْ ٘ا،قايؿ ِٚٛلؼيت پًٕ ٘اي ِطتٍف تؽعثك اّ٘يت .ِي تانع  ٘اي 
 .آٔٙا تؽاي واؼتؽاْ ضاو ،تغييؽِيىٕع

Stage: 

ايٓ يفسٗ ناًِ ِتٓ ،تًاٚيؽ .ٔاَ ظاؼظ ( ٔٗ ّٔايم ير)Stageِكتغيً تؿؼگ ٚقفيعؼٔگي وٗ ظؼ ٚقظ يفسٗ ِها٘عٖ ِيىٕيع 
تٗ عٛؼ .تاػث خاتدانعْ آٔٙا ظؼ واؼ نّا ِي نٛظ  Stageخاتداوؽظْ اٌّاْ ٘ا ؼٚي  .ٚٚيعئٛيي اقت وٗ ؼٚي يفسٗ ظا٘ؽ ِيهٛظ

تؽاي تيٕٕعگاْ  لؽاؼ ظاؼظ وٗ ِيتٛأيع اٌّاْ ٘اي ِٛؼظ ٔظؽ ضٛظ ؼا وٗ ّٔي ضٛا٘يع  Stageپيم فؽٌ ،فضايي ضاوكتؽي ؼٔگ ظؼ 
ؼا تثيٕيع ٚ ايٓ فضا ؼا زػف   Stageتؽاي ايٕىٗ فمظ .ٔاَ ظاؼظ   Pasteboardايٓ فضاي ضاوكتؽي .ّٔايم ظاظٖ نٛظ ظؼ آْ لؽاؼ ظ٘يع

ي تؿؼگّٕايي ؼا اؾ ِٕٛي تالاي آْ اِيتٛأيع زاٌت ٖ Stageتؽاي تغييؽ قايؿ .ؼا أتطاب وٕيع View>Pasteboardوٕيع ِيتٛأيع ِكيؽ 
 .اقتفاظٖ ِيىٕيُ( پًٕ ػّٛظي قّت ؼاقت ) Propertiesاؾ پًٕ  Stageتؽاي تغييؽ ظاظْ ظيگؽ ِهطًات .تطاب وٕيعاْ

 : Libraryپىو 
ِيتٛاْ آيتُ ٘ايي ؼا وٗ لؽاؼ اقت ظؼ ِكتٕع ،ِٛؼظ اقتفاظٖ لؽاؼ . ؼاايداظ ِيىٕعايٓ پًٕ ،اِىاْ ِؽتة وؽظْ آيتُ ٘ا ظؼ فٌٛعؼ٘ا 

 .تؽاي ٚاؼظ وؽظْ يه آيتُ تٗ ايٓ پًٕ ،ِكيؽ ؾيؽ ؼا عي ِيىٕيُ.وؽظ  Stageٚ تٗ ِؽٚؼ ٚاؼظ ايٓ پًٕ لؽاؼ ظاظتگيؽظ ؼا ظؼاتتعاي واؼظؼ
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File>Import>Import to Library 

   Stageفمظ وافيكت پف اؾ أتطاب آْ ٚتاپاييٓ ٔگٗ ظانتٓ ِٛـ،آٔؽا تٗ ؼٚي  Stageظؼ Libraryتؽاي تٗ واؼتؽظْ آيتُ ٘اي پًٕ 
 .تىهيع

Timeline: 
ّٔايم  Timelineفٍم ،اعلاػاتي ٔظيؽنّاؼٖ فؽيُ ،ٔؽش وٕٛٔي فؽيُ ٚ ؾِأي وٗ تاوْٕٛ ظؼ فيٍُ گػنتٗ اقت ؼا ظؼ لكّت پاييٓ 

٘ؽ لايٗ ناًِ تًٛيؽ ِتفاٚتي .ظاْناًِ لايٗ ٘ايي اقت وٗ تٗ نّا ظؼ قاؾِأع٘ي ٕ٘ؽي پؽٚژٖ ياؼي ِيؽـ Timeline.ِيع٘ع
فؽيُ ٘اي ٘ؽلايٗ يىتا ٘كتٕع ٚنّا تٕٙا ِيتٛأيع آٔٙا ؼا تا پاييٓ ٔگٗ ظانتٓ ِٛـ،تٗ .نٛظظا٘ؽ ِي   Stageاقت وٗ ظؼ ؼٚي 

 .ِٛلؼيت خعيعي ؼٚي ّ٘اْ لايٗ تىهيع يا آٔٙا ؼا وپي ٚتٗ لايٗ ظيگؽي ِٕتمً وٕيع

 :تغييز ًام لايه -

 ظٚتاؼ وٍيه وؽظْ تؽ ؼٚي لايٗ ،تغييؽ ٔاَ ،وٍيه تؽ ؼٚي يه لكّت ظيگؽ

 :قفل كزدى لايه-

لفً وؽظْ لايٗ تاػث ِي نٛظ وٗ ظؼ اثؽ انتثاٖ ٔتٛاْ آٔؽا .ظؼ ؾيؽ آيىٕي وٗ تٗ نىً  لفً اقت وٍيه وٕيع تا لايٗ ؼا لفً وٕيع 
 .تغييؽ ظاظ

 :اضافه كزدى لايه جذيذ-

Insert> Timeline> Layer.1 

 .لؽاؼ ظاؼظ ٔيؿ اقتفاظٖ وؽظ  Timelineوٗ ظؼ پاييٓ   New Layerِيتٛاْ اؾ ظوّٗ 2.

 :حذف لايه -

 وؽظْ آْ   Deleteأتطاب لايٗ ٚ 

 :ايجاد پوشه هاي لايه -

تؽاي ايٕىاؼ لايٗ ؼا أتطاب .ؾِأي وٗ تؼعاظ لايٗ ٘اي ايداظ نعٖ ؾياظ تانع ،ِيتٛاْ تؽاي قاؾِأع٘ي آْ اؾ پٛنٗ اقتفاظٖ وؽظ 
تؽاي اضافٗ وؽظْ لايٗ ٘ا .الاي لايٗ ايداظ ِي نٛظيه پٛنٗ لايٗ خعيع،ظؼ بؼاوٍيه ِيىٕيُ تٗ ايٓ تؽتية   New Folderٚؼٚي ظوّٗ 

 .تٗ ايٓ پٛنٗ وافيكت پف اؾ أتطاب لايٗ ،آٔؽا تٗ ظاضً پٛنٗ تىهيُ

 :Timelineتغيير دادن ظاٌر 
ظؼ گٛنٗ تالا قّت ؼاقت  Frame Viewاگؽ ِيطٛا٘يع لايٗ ٘اي تيهتؽي ؼا تثيٕيع ِيتٛأيع اؾ گؿيٕٗ 

Timeline  ٕٗلؽاؼ ظاؼظ ،گؿيShort ِيتٛأيع ػؽٌ ضأٗ ٘اي ِؽتٛط تٗ فؽيُ ٘ا ؼا تا أتطاب .ؼا أتطاب وٕيع
ػؽٌ فؽيُ ٘ا وُ ٚؾياظنعٖ   Largeتا Tinyتاأتطاب يىي اؾ أعاؾٖ ٘اي .تغييؽ ظ٘يعيىي اؾ گؿيٕٗ ٘اي 

ِي تٛاْ ِستٛاي فؽيُ  Previewتاتيه گؿيٕٗ .ٚنّاؼٖ ٘اي آْ ظليك تؽ ياوٍي تؽٔهاْ ظاظٖ ِي نٛظ
 .تٗ يٛؼت زعٚظي ِها٘عٖ وؽظيعي ؼا ظؼْٚ ضظ ؾِاْ ٘اي وً

 :Propertiesپىو 
آٔچٗ ظؼ ايٓ پًٕ ظا٘ؽ ِي نٛظ تكتگي تٗ آْ .ايٓ پًٕ ،تٗ نّا اِىاْ ظقتؽقي تٗ ٚيژگيٙايي ؼا ِيع٘ع وٗ اغٍة ٔياؾ ظاؼيع 

ٔيؿ اؾ ايٓ پًٕ اقتفاظٖ    Stageيؽظؼ ؼٚي تؽاي خاتٗ خاوؽظْ تًاٚ... چيؿي ظاؼظ وٗ نّا أتطاب وؽظٖ ايع ِثً تغييؽ ػؽٌ ٚ اؼتفاع ٚ 
 .ضٛا٘يُ وؽظ

 :Toolsپىو 

ٚلتي اتؿاؼي ؼاأتطاب ِيىٕيع،گؿيٕٗ .ايٓ پًٕ ناًِ اتؿاؼ ٘اي أتطاب،تؽقيُ ٚتايپ،اتؿاؼ٘اي ٚيؽايم،پيّايم ٚغيؽٖ ِي تانع
 .گؿيٕٗ ٘ا اقتفاظٖ وٕيع ٘ايي ظؼؾيؽ ايٓ پًٕ تؽاي تٕظيّات لؽاؼظاظٖ ِي نٛظ وٗ ِيتٛأيع تٕا تٗ واؼتاْ اؾ ايٓ

 :(Selection tool)اتسار اوتخاب

تؽاي اػّاي تغييؽات تؽؼٚي لكّت ضايي اؾ .تٗ وّه ايٓ اتؿاؼ،ِيتٛأيعتطم ٘اي ِٛؼظٔظؽيفسٗ ؼاأتطاب وٕيع
 تؽاي أتطاب يه لغؼٗ ضظ يا يه تطم يىپاؼچٗ ؼٔگي،وافيكت تاؼٚي آْ يىثاؼ وٍيه. نىً،اتتعاتايع آٔؽا أتطاب وٕيع
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تؽاي أتطاب تّاَ نىً وافيكت ظؼ ٔمغٗ اي اؾآْ ظٚتاؼ وٍيه .ٔمغٗ ٔمغٗ نعْ نىً ،ٔهأٗ أتطاب اقت.وٕيع
تثعيً ضغٛط لائُ تٗ ِٕسٕي ٚتغييؽعٛي ٚخٙت )اؾظيگؽ لاتٍيت ٘اي اتؿاؼ أتطاب،تٛأايي آْ ظؼ ٚيؽايم ضغٛط ٚانىاي.وٕيع
 . زؽوت ظاظْ نىً اقت ٚ (ضظ

 :(Lasso Tool)اتسارممىذ

تؽاي .ايٓ اتؿاؼ ٔيؿٚقيٍٗ اي تؽاي أتطاب اقت ٚتٗ وّه آْ،ِيتٛاْ ِسعٚظٖ ٘ايي تانىً ٔإِظُ ؼاأتطاب وؽظ

نىً زؽوت ظ٘يع تا يه ؼٚي تطهي اؾ ٚواؼتا ايٓ اتؿاؼ وافيكت آٔؽا أتطاب وؽظٖ ،اناؼٖ گؽ ِٛـ ؼا پاييٓ ٔگٗ ظانتٗ 
 .ِسعٚظٖ تكتٗ ايداظ نٛظ

 :(SubselectionTool)اتسار اوتخاب فرػي 

ايٓ اتؿاؼ تؽاي ٚيؽايم ظليك نىً واؼتؽظ ظاؼظ،چٕأچٗ ايٓ اتؿاؼ ؼافؼاي وؽظٖ ٚؼٚي ضغٛط زانيٗ اي يه نىً وٍيه 
٘ؽٔمغٗ ٚيؽايهي ظاؼاي ظٚظقتگيؽٖ اقت وٗ تازؽوت ظاظْ ايٓ ظقتگيؽٖ ٘ا .ّٔاييع،ٔماط ٚيؽايهي نىً ظا٘ؽ ِي نٛظ

 .ِي تٛاْ تغييؽات ظؽيفي ظؼ نىً ايداظ وع

 :(Eraser Tool)تسار پاك مها

تاأتطاب ايٓ اتؿاؼ ،ظؼ تطم تٕظيّات ٌيكت .ايٓ ٚقيٍٗ تؽاي پان وؽظْ ضغٛط يا ؼٔگ آِيؿي ٘اي ؾايع واؼتؽظ ظاؼظ

ِٕٛيي تؽاي تٕظيُ ظليك  Eraser modeّ٘چٕيٓ تاوٍيه وؽظْ ؼٚي ظوّٗ  .پاوٕٙاي ِٛخٛظ تاأعاؾٖ ٚاتؼاظ ِتٕٛع ظا٘ؽ ِيهٛظ
  .ِي نٛظػٍّىؽظ پاوٓ تاؾ

Eraser Normal -: ظؼ ايٓ ٚضؼيت اتؿاؼ پاک کٓ ، ٘ؽ آٔچٗ ؼا کٗ ظؼ ِٛلغ کهيعْ آْ ؼٚی
 .ِٛضٛع ِی تيٕع پاک ِی ّٔايع

-Eraser Fill : ايٓ أتطاب ظؼ ؾِاْ پاک کؽظْ پؽ کٕٕعٖ ٘ا تعْٚ زػف ضغٛط ِسيغی کاؼتؽظ
  .ظاؼظ

-Eraser Lines  : ؼظ ٚ پؽکٕٕعٖ ٘ا ؼا ّ٘چٕاْ تؽای زػف ّٔٛظْ ضغٛط ِسيغی کاؼتؽظ ظا
  . ٔگٗ ِی ظاؼظ

-Eraser Selected Fills  : تؽای پاک ّٔٛظْ پؽ کٕٕعٖ ٘ايی کٗ لثً اؾ أتطاب Eraser Tool 
 . أتطاب نعٖ أع اؾ ايٓ زاٌت اقتفاظٖ ّٔائيع

-Eraser Inside :  ًّیکٕعَظؼ ایٓ زاٌت پاک کٓ تٕٙا ظؼ ظاضً نکً ٚ تؽ ؼٚی ؾِيٕٗ ػ . 
-Eraser Shape: اؾ ایٓ لكّت ِيتٛاْ نکً ٚ أعاؾٖ پاک کٓ ؼا أتطاب کؽظ . 

-Faucet: ظاؼای ظٚ زاٌت أتطاتي On , Off  تا فؼاي کؽظْ ايٓ گؿيٕٗ ، اتؿاؼ . ِی تانع
 . پاک کٓ تا يک تاؼ کٍيک کؽظْ ، يک ضظ ٚ يا پؽکٕٕعٖ کاًِ ؼا پاک ِی ّٔايع

 کافی اقت ؼٚی پاک کٓ ظؼ خؼثٗ اتؿاؼ ظتً کٍيک کٕيع Stage ظؼتؽای پاک کؽظْ تّاِی انکاي ِٛخٛظ  :   ٔکتٗ
 

 :(Line Tool)اتسار خظ 

اگؽ ٕ٘گاَ فؼاي تٛظْ ايٓ اتؿاؼ،لاب .تافؼاي وؽظْ ايٓ گؿيٕٗ ِيتٛاْ تؽؼٚي يفسٗ ضغٛط ِكتميُ ؼقُ وؽظ
 (style)،نيٖٛ ّٔايم (color)،ؼٔگ (stroke)ؼا تاؾ وٕيع ِيتٛأيع تٕظيّات لٍُ اؾ خٍّٗ ضطاِت( Properties)تٕظيّات

 .ايٓ تٕظيّات ؼاِيتٛاْ لثً اؾ تؽقيُ ضظ يا پف اؾ ؼقُ آْ ٚ أتطاب ضظ اػّاي وؽظ.ؼاأداَ ظ٘يع 
ِيتٛاْ يىي اؾ گؿيٕٗ  capظوّٗ تاأتطاب ضظ ٚوٍيه تؽؼٚي .ظؼ أتٙاي لاب تٕظيّات ظٚ تٕظيُ ُِٙ ظيگؽ ٚخٛظ ظاؼظ : ٔىتٗ

 .تٗ آْ زاٌت ِؽتؼي ِيع٘ع squareأتٙاي ضظ ؼاگؽظ ِيىٕع ٚ  round.ظؼاأتطاب وؽ Squareيا  Round٘اي 

 :(Brush Tool)اتسار قيمُ

لٍّٛي فٍم ،نثيٗ لٍّٛي ٔماني ؼٚي تَٛ ػًّ ِيىٕع ٚنىً ،ضطاِت ٚؼٔگ آْ ظؼ تطم تٕظيّات ،لاتً 

قتفاظٖ اؾ گؿيٕٗ ٘اي ايٓ زاٚي زاٌت ٘اي لٍّٛ لؽاؼ ظاؼظ وٗ تا Brush modeظؼ تطم تٕظيّات لٍّٛ،ِٕٛي . تٕظيُ اقت
 :ايٓ أتطاب ٘ا تٗ يٛؼت ؾيؽ ػًّ ِيىٕٕع.تٛقظ لٍّٛؼاتٗ تطم ٘اي ضايي اؾ نىً ِسعٚظ وؽظِٕٛ ِيتٛاْ ؼٔگ آِيؿي 
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 .ؼٔگ تؽؼٚي تّاَ ٔماط نىً وهيعٖ ِي نٛظ:(Normal)حالت عادي -
 .ؼٔگ تؽؼٚي تّاَ نىً تٗ خؿضغٛط زانيٗ اي اػّاي ِيگؽظظ(:Fill)حالت غيزخطي-
 .تطم ؾيؽيٓ نىً ؼٔگ آِيؿي ِي نٛظ(:Behind)حالت سيزيي-
 .ؼٔگ تٕٙا ظؼ تطم ٘اي أتطاب نعٖ نىً اثؽ ِيگػاؼظ:Selection))حالت اًتخاتي-
اگؽ ؼٔگ آِيؿي ؼا اؾظؼْٚ نىً آغاؾ وٕيع،ؼٔگ تعْٚ تاثيؽتؽضغٛط زانيٗ اي تٕٙا ظؼْٚ نىً (:Inside)حالت دروًي-

 .ؾ تيؽْٚ نىً نؽٚع نٛظ تؽ ظاضً نىً اثؽ ّٔيگػاؼظٔمم ِيثٕعظ ٚاگؽ ؼٔگ آِيؿي ا
 .ٔيؿ ِإٔع اقپؽي ٘اي ؼٔگ پال،ؼٔگ أتطاب نعٖ ظؼ لاب تٕظيّات ؼا تؽؼٚي يفسٗ ِيپانع  Spray Brushدكوه 

 :(Pencil Tool)اتسار مذاد

ايٓ اتؿاؼ  Line ٚ Pen اتؿاؼ٘ای ِٛؼظ اقتفاظٖ لؽاؼ ِی گيؽظ ٚ تؽ ضلاف( ِٕظُ یا ٔإِظُ )ايٓ اتؿاؼ تؽای تؽقيُ ٘ؽ ٔٛع ضظ 
  ّ٘گاَ تا زؽکت ِٛـ زؽکت ِيکٕع

قٗ زاٌت Options تا أتطاب ايٓ اتؿاؼ ظؼ لكّت.ٚ تؽای افؿٚظْ خؿئيات تٗ ِٛضٛع ِٕاقة ِی تا نع
  : زاٌت ػثاؼتٕع اؾ 3اضتياؼی ِها٘عٖ ضٛا٘ع نع ايٓ 

Straighten- : ًًظؼ ايٓ . تٗ ُ٘ ّٔايم ِيع٘ع ضغٛط ؼقُ نعٖ ؼا تٗ يٛؼت پاؼٖ ضغٙای ؼاقت ِت
زاٌت اگؽ نکٍٙايی تًٛؼت تمؽيثاً کّأی يا تيضی ؼقُ کٕيع آْ نکٍٙا تًٛؼت کّاْ يا تيضی کاًِ ظؼ 

 .ضٛإ٘ع آِع
Smooth- : ضغٛط ّ٘ٛاؼی ؼقُ ِيکٕع. 

Ink- : ٖتٚ ظاؼای کّتؽيٓ ِيؿاْ ّ٘ٛاؼکٕٕعگی اـ. ايع زفظ ِيکٕع ضغٛط ؼا تمؽيثا تٗ ّ٘اْ نکٍی کٗ کهيع. 

 :(Rectangle Tool)اتسار رضم غنو
ؼٔگ ٘اي زانيٗ .تاأتطاب اتؿاؼ٘اي ِٛخٛظ ظؼايٓ ظوّٗ،ِيتٛاْ تؽؼٚي يفسٗ ِكتغيً ،تيضي،قتاؼٖ ياچٕعضٍؼي وهيع
تؽاي ؼقُ يه .ٚظؼْٚ نىً ؼقُ نعٖ ِغاتك ؼٔگ ٘اي خؼثٗ اتؿاؼ ضٛا٘عتٛظ

ضً وٍيه وؽظٖ وافيكت ؼٚي ؼٔگ زانيٗ يا ؼٔگ ظانىً تٛضاٌي يا تعْٚ زانيٗ ،
ي ُ٘ ظؼلاب ضطاِت ٚزاٌت ضغٛط زانيٗ ا.ٚگؿيٕٗ تعْٚ ؼٔگ ؼا أتطاب وؽظ

 .تٕظيّات تؼييٓ ِي نٛظ
 :ٔىتٗ

ؼا پاييٓ ٔگٗ ظاؼيع،اتؿاؼ ِكتغيً ٚظايؽٖ زتّا Shiftاگؽ ٕ٘گاَ ؼقُ نىً ،وٍيع .1
 (ٔٗ ِؽتغ يا تيضي)ِكتغيً يا ظايؽٖ ؼقُ ِيىٕٕع 

قتغيً،ؾتأٗ اي ٚخٛظ ظاؼظ وٗ تازؽوت ظاظْ آْ ِيتٛأيع چٙاؼگٛل ِكتغيً ؼا گؽظ يا ظؼأتٙاي لاب تٕظيّات اتؿاؼ َ.2
 .ظؼاتؿاؼ ظايؽٖ ُ٘ ايٓ تٕظيُ تاػث ِي نٛظاِىاْ ؼقُ لغاع ياظايؽٖ تٛضاٌي فؽاُ٘ نٛظ.فؽٚؼفتٗ وٕيع

تٍي آْ ظؼ ٚخٛظ ٔماط ٚيؽايهي ٚخٛظظاؼظ وٗ تفاٚت آٔٙا تا اتؿاؼ٘اي ق (Primitive)ظؼايٓ ظوّٗ،ظٚاتؿاؼ ِكتغيً ٚظايؽٖ اٌٚيٗ 
ٕ٘گاِي وٗ تاايٓ اتؿاؼ نىٍي ؼاؼٚي يفسٗ ؼقُ ٚقپف تااتؿاؼ أتطاب ؼٚي آٔٙا وٍيه .ؼٚي نىً ٘اي ؼقُ نعٖ اقت 

 .ِيىٕيع،تؼعاظي ٔماط ؼٔگي ؼٚي آٔٙا ايداظ ِي نٛظ وٗ زؽوت ظاظْ آٔٙا تاػث تغييؽ زاٌت نىً ضٛا٘ع نع
ِيتٛاْ  Optionتاأتطاب ايٓ اتؿاؼ ٚؼفتٓ تٗ تطم .ٚقتاؼٖ اقت   (Polygon)ظضٍؼي اتؿاؼ آضؽ ظؼ ايٓ ظوّٗ تؽاي ؼقُ چٓ

 .ٔٛع نىً ٚتؼعاظ گٛنٗ ٘ا ٚپؽ٘اؼا تؼييٓ وؽظ

 :(Deco Tool)اتسار دمُ

 .ايٓ اتؿاؼ،ٚقيٍٗ اي تكياؼ واؼآِعتؽاي ؼقُ عؽذ ٘اي تىؽاؼنٛٔعٖ ِثً گً ٚتٛتٗ يا تًاٚيؽ ِتماؼْ اقت
يه ٌيكت تاؾنٛٔعٖ ٚخٛظ ظاؼظ وٗ اٌٚيٓ گؿيٕٗ تؽاي ؼقُ گً ٚتٛتٗ ظِٚيٓ  Drawing Effectsضم پف اؾأتطاب اتؿاؼ،ظؼب

 .تؽاي ؼقُ نثىٗ اي ٚگؿيٕٗ قَٛ تؽاي ؼقُ نىً ٘اي ِتماؼْ اقت 
ؼٔگ تؽگ  Leafتطم لكّت تٕظيّات اؾظؼٕ٘گاَ ؼقُ گً ٚتٛتٗ، ِيتٛاْ ظؼ :ٔىتٗ

اٌثتٗ اگؽ لثلا تؽگ أتطاب )ْ وؽظتؽگ خعيعي ؼا خايگؿي Edit٘اؼاتغييؽظاظ ٚظؼتطم 
،اِىاْ تغييؽ ؾاٚيٗ  Advanced Optionظؼتطم .(نعٖ قّثً گؽافيىي نعٖ تانع

 Animate Patternگؿيٕٗ .قالٗ ٘ا،اتؼاظ اٌگٛٚعٛي لغؼات تىؽاؼنٛٔعٖ ٚخٛظ ظاؼظ
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 .ؼٚٔع عؽازي گً ٚتٛتٗ تٗ يه أيّيهٓ قاظٖ تثعيً ضٛا٘ع نع

 :(Bone Tool)اتسار اضتخُان تىذي

ايٓ اتؿاؼتؽاي نثيٗ قاؾي تؽضي زؽوت ٘ا ِثً زؽوت ظقت ٚپاٚيا ٘ؽ زؽوت پيچيعٖ اي وٗ زٛي يه ِفًً أداَ 
 .(آِٛؾل ایٓ اتؿاؼ ، ضاؼج اؾ قؽفًً کتاب اقت).نٛظ ،تىاؼ ِيؽٚظ

 :(Pen Tool)اتسار قيم

اتتعا ظؼٔمغٗ اي اؾ تؽاي ؼقُ ضغٛط ِٕسٕي ، .ايٓ اتؿاؼ تؽاي ؼقُ ضغٛط ِٕسٕي پيچيعٖ اقتفاظٖ ِي نٛظ 
تاخاتٗ خاوؽظْ .يفسٗ وٍيه وؽظٖ ٚپف اؾ وٍيه ظؼٔمغٗ ظَٚ،ضّٓ پاييٓ ٔگٗ ظانتٓ ظوّٗ ِٛـ،اناؼٖ گؽؼازؽوت ظ٘يع

ظؼظوّٗ اتؿاؼ لٍُ،قٗ اتؿاؼ تىّيٍي ظيگؽُ٘ ٚخٛظ ظاؼظ .ظقتگيؽٖ ٘اي ظا٘ؽنعٖ ،ِٕسٕي تٗ نىً ظٌطٛاٖ ٔؿظيه ِي نٛظ
 .نعٖ واؼتؽظ ظاؼٔعوٗ تؽاي ٚيؽايم ظليك تؽِٕسٕي ؼقُ 

 :(Paint Bucket Tool)اتسار ضطو روگ

ؼٔگ ظٌطٛاٖ ؼاتايع .تااقتفاظٖ اؾايٓ ٚقيٍٗ ِيتٛاْ تطم تكتٗ اي اؾتًٛيؽؼا تاؼٔگ يانية ؼٔگ ظٌطٛاٖ پؽوؽظ
 .اؾتطم ؼٔگ ٘اي خؼثٗ اتؿاؼأتطاب وؽظ

 :(Eyedropper)اتسار ومُوً ترداري

ت،ِيتٛاْ اؾؼٔگ ياقايؽضًٛييات يه نىً ياضظ ،ّٔٛٔٗ تؽظاؼي تٗ وّه ايٓ اتؿاؼوٗ نثيٗ لغؽٖ چىاْ اـ

تؽاي ّٔٛٔٗ تؽظاؼي اؾٚيژگي ٘اي يه ضظ ٔظيؽ زاٌت،ضطاِت ٚؼٔگ ِيتٛأيع تااتؿاؼّٔٛٔٗ تؽظاؼي ؼٚي آْ وٍيه وؽظٖ .وؽظ
 .نيهٗ خٛ٘ؽتٗ وّه آْ ؼٚي ضظ ظيگؽي وٍيه وؽظٖ تاضًٛييات ضظ اٚي تٗ آْ ِٕتمً نٛظٚپف اؾظا٘ؽنعْ 

ِيىٗ لغؽٖ چىاْ ِهغٛي ّٔٛٔٗ تؽظاؼي اؾ ؼٔگ اقت ظؼوٕاؼآْ ػلاِت لٍّٛظا٘ؽِي نٛظٚچٕأچٗ ّٔٛٔٗ تؽظاؼي ٕ٘گا
 .اؾضًٛييات ضغٛط يٛؼت گيؽظ،ػلاِت ِعاظ ّٔاياْ ِي نٛظ

 :(Free Transform)اتسارتغييرغنو
اؼ ٚوٍيه ؼٚي نىً ِٛؼظ فؼاي وؽظْ ايٓ اتؿپف اؾ .تغييؽأعاؾٖ،خٙت ٚظا٘ؽ نىً ٘ا تٛقظ ايٓ اتؿاؼأداَ ِي نٛظ 

 .ظقتگيؽٖ ظؼ اعؽاف نىً ظا٘ؽ ِي نٛظ وٗ تٗ وّه آٔٙا ِيتٛاْ نىً ؼاتؿؼگ ياوٛچه وؽظٖ ياآٔؽا چؽضأع8ٔظؽ،يه واظؼتا
 

اگؽ ِيطٛا٘يع زيٓ تؿؼگ ياوٛچه وؽظْ نىً،ٔكثت اتؼاظ  زفظ نٛظ تايع اؾظقتگيؽٖ ٘اي چٙاؼگٛل واظؼ : ٔىتٗ   
ظا٘ؽنعْ ػلاِت ٔيُ ظايؽٖ ظؼوٕاؼاناؼٖ گؽ ،ِيتٛاْ  تا .اظؼزيٓ تغييؽ أعاؾٖ پاييٓ ٔگٗ ظاؼيعؼ Shiftاقتفاظٖ ّٔٛظٖ ٚوٍيع 

ػلاٖٚ تؽايٓ تأؿظيه وؽظْ اناؼٖ گؽ تٗ ضغٛط واظؼ ،ػلاِت ظٚپيىاْ ِٛاؾي ّٔاياْ ِي . نىً ؼاتٗ ِيؿاْ ظٌطٛاٖ چؽضأع
 .پيعا ِيىٕعٌت ضٛاتيعٖ نٛظ وٗ تاوٍيه وؽظْ ٚزؽوت ظاظْ اناؼٖ گؽ ظؼ خٙت پيىاْ ٘ا،نىً زا

 :(Zoom Tool)اتسار رري تيه

 .ػٍّىؽظ آْ تؽػىف ِي نٛظ Altتأگٗ ظانتٓ ظوّٗ .تاوّه ايٓ اتؿاؼ ِيتٛاْ تؿؼگ ّٔايي نىً ؼا وُ ياؾياظ وؽظ 

 :(Hand Tool)اتسار دضت

ؼوت ٚخاتٗ خايي چٕأچٗ تؿؼگ ّٔايي يفسٗ اي ؾياظ تٛظ ِٚها٘عٖ ّ٘ٗ ِستٛيات يفسٗ اِىاْ پػيؽ ٔثٛظ،تؽاي ذ
 .ظؼٔماط ِطتٍف ِي تٛاْ اؾ ايٓ اتؿاؼ اقتفاظٖ وؽظ

 :(Text Tool)اتسار تايپ

تؽاي تٕظيُ ؼٔگ ،أعاؾٖ ٚٔٛع لٍُ ٚ ظيگؽ تٕظيّات  .تؽاي ٔٛنتٓ ػثاؼات تؽؼٚي يفسٗ اتتعا تايع ايٓ اتؿاؼ ؼافؼاي وؽظ
 . انکاي یک نيئ ظؼ ٔظؽ گؽفتٗ ِی نٛٔعظؼ فٍم ِتٓ ٘ا ٔيؿ ِإٔع تميٗ .تايع تٗ قؽاؽ تطم تٕظيّات آْ ؼفت

 
 :تٓ ٘ا ظؼ فٍم تٗ قٗ ظقتٗ ِدؿا تمكيُ ِی نٛٔعَ

1. Static)) ظؼ ایٓ ٔٛع ِتٓ ٘يچگٛٔٗ تغييؽی ظؼ ٕ٘گاَ ّٔایم أيّيهٓ :ثاتت
ثاتت تٗ ایٓ ِؼٕی ٔيكت کٗ ِتٓ نّا لاظؼ تٗ . تٛخٛظ ّٔی آیع ٚ ِتٓ نّا ثاتت ضٛا٘ع تٛظ 

 . اقت کٗ ِتٓ نّا لاتٍيت تغييؽ ؼا ٔعاؼظ زؽکت ٔيكت تٍکٗ ِٕظٛؼ ایٓ
2. Dynamic))ضلاف ِتْٛتؽ: ِتغيؽ Static  ٗایٓ ٔٛع ِتٓ لاتٍيت تغييؽ ؼا ظاؼظ ک
تا تٛخٗ تٗ ِتغييؽی کٗ تٗ ِتٓ ٔكثت ِی ظ٘يُ اػّاي ِی  ActionScript ایٓ تغييؽ تٛقظ

ؼا تٗ ِتغييؽی کٗ تؽای  HTML ظ٘ایایٓ اقت کٗ ِی تٛأيُ ک Static تفاٚت ظیگؽ ایٓ ٔٛع ِتٓ تا ِتْٛ. نٛظ 
 . قاظٖ ظؼ فٍم ظانتٗ تانيُ HTML ِتٓ تؼؽیف کؽظیُ ٔكثت ظ٘يُ ٚ یک يفسٗ
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3. Input))ایٓ ٔٛع ِتٓ تّاِی ضٛاو ِتْٛ: ٚؼٚظی Dynamic  ؼا ظاؼاقت تا ایٓ تفاٚت کٗ کاؼتؽ لاظؼ تٗ تغييؽ ِتٓ ظؼ
اؾ کاؼتؽ اقتفاظٖ ِی نٛظ ِإٔع یک فؽَ کٗ اؾ کاؼتؽ اؾ ایٓ ٔٛع ِتٓ تؽای گؽفتٓ ٚؼٚؼظی . زاي ّٔایم ضٛا٘ع تٛظ

 .ِی ضٛا٘يُ آْ ؼا پؽ کٕع
 

 :Text روش کار با

 : ظؼ خؼثٗ اتؿاؼ ظؼ زاٌت أتطاب تانع Text اگؽ اتؿاؼ
 

Static Text:    

ٖ ٔهاْ ایٓ ظایؽ.قّت ؼاقت آْ یک ظایؽٖ اقت  ،کٍيک کٕيع یک کاظؼ تاؾ ِی نٛظ کٗ ظؼ گٛنٗ تالا  Stage ٘ؽ ٚلت ظؼ
ِتٕاقة تا ِتٓ نّا تًٛؼت ضٛظکاؼ تؿؼگ ٚ کٛچک  ،ظٕ٘عٖ آْ اقت کٗ کاظؼی کٗ ِتٓ نّا ؼا ظؼ تؽِيگيؽظ اؾ ٔظؽ ػؽضی 

  . لاتً افؿایم اقت Enter ِی نٛظ ٚ اؼتفاع کاظؼ ُ٘ تا ظکّٗ
تؼع اؾ یک تاؼ تغييؽ ظاظْ تا پائيٓ ٔگٗ ظانتٓ ظکّٗ چپ ِاٚـ ؼٚی یکی اؾ گٛنٗ ٘ا ِيتٛأيع ػؽٌ کاظؼ ؼا تغييؽ ظ٘يع اِا 

ظایؽٖ گٛنٗ تالا قّت ؼاقت تٗ یک ِؽتغ کٛچک تثعیً ِی نٛظ ٚ ضاييت تؿؼگ ٚ کٛچک کؽظْ ضٛظکاؼ ضٛظ ؼا اؾ ظقت  ،
تٗ ضظ تؼع ِی ؼٚظ ٚ نّا  Enter ّ٘چٕيٓ ػؽٌ کاظؼ نّا ثاتت ضٛا٘ع نع ٚ ِتٓ نّا تعْٚ ٔياؾ تٗ ظکّٗ. ِی ظ٘ع 

 . ٚـ ؼا ٔعاؼیعاِکاْ تٕظيُ اؼتفاع کاظؼ تا ِا
 ،تؽای تاؾگهت تٗ زاٌت تٕظيُ أعاؾٖ ػؽٌ کاظؼ تٗ يٛؼت ضٛظکاؼ ٚ تثعیً ِؽتغ تالا قّت ؼاقت کاظؼ تٗ ظایؽٖ  : ٔکتٗ

  . کافی اقت ؼٚی ِؽتغ ظتً کٍيک کٕيع

 
Dynamic Text: 

ٚ ٚقظ چٙاؼ ضٍغ  یک کاظؼ ظا٘ؽ ِی نٛظ کٗ ظؼ گٛنٗ پائيٓ قّت ؼاقت یک ظایؽٖ تٛضاٌی ظاؼظ Stage تا کٍيک ؼٚی
 . ضٛظ ٔيؿ چٙاؼ ِؽتغ کٛچک ظاؼظ

 . نّا اِکاْ تغييؽ ظاظْ اؼتفاع کاظؼ ؼا ٔيؿ ظاؼیع Static ضلاف زاٌتتؽ
تٛخٗ ظانتٗ تانيع کٗ کاؼتؽ فمظ ِی تٛأع تٗ أعاؾٖ کاظؼ ِٛخٛظ اؾ ِتٓ نّا ؼا تثيٕع یؼٕی اگؽ یک کاظؼ کٛچک أتطاب 

یک ِتٓ عٛلأی ٔكثت ظ٘يع کاؼتؽ لاظؼ تٗ ِها٘عٖ تّاِی آْ ٔطٛا٘ع تٛظ  Dynamic Text کٕيع ٚ تؼع تٗ ِتغيؽ ِؽتٛط تٗ
  . ضٛا٘ع ظیع ،ٚ فمظ تطهی اؾ آْ ؼا کٗ ظؼ کاظؼ خا ِی نٛظ

 

Input : 
 . اقت Dynamic ؼٚل ِإٔع زاٌت

 

 

  :Propertiesدر پاوو Text َيژگی ٌای

 
Instance Name : 

 .اؾ آْ اقتفاظٖ کٕيع ActionScript ِٛٔٗ ٚاؼظ کؽظٖ ٚ ظؼِی تٛأيع ظؼ ایٓ لكّت ٔاِی ؼا تؽای ْ
 

Letter spacing(فاصله تيي حزوف): 
اگؽ تٗ قّت ِٕفی تؽٚیُ . تٕظيُ نٛظ  يفؽ تؽای تٕظيُ فايٍٗ تيٓ زؽٚف اقتفاظٖ ِی نٛظ کٗ ظؼ زاٌت ػاظی تایع ؼٚی

 . ف اؾ ُ٘ فايٍٗ ِی گيؽٔعزؽٚ ،تا ِماظیؽ ِثثت  ،زؽٚف ظؼُ٘ ؼفتٗ ِی نٛٔع ٚ تا افؿایم ِمعاؼ آْ 
Character Position: 

تؽای گػانتٓ تٛاْ  Superscript تؽای ِتْٛ ػاظی Normal :تؽای تؼييٓ ٔٛع یک زؽف تکاؼ ِيؽٚظ ٚ ظاؼای قٗ زاٌت اقت
ٚ Subscript تؽای گػانتٓ أعیف . 

 
Embed:  

ِٕظٛؼ تؽ ؼٚی ظکّٗ ِؽتٛعٗ کٍيک کٕيع ٚ ظؼ کاظؼ تاؾ تؽای ایٓ . تا اقتفاظٖ اؾ ایٓ گؿیٕٗ ِی تٛأيع فایً ؼا خاقاؾی کٕيع 
ؼا کٍيک کٕيع  Auto Fill ظؼ يٛؼتی کٗ ظکّٗ . نعٖ تؼييٓ کٕيع کٗ کعاَ کاؼاکتؽ تایع ظؼ اٌّاْ ِتٕی لؽاؼ ظاظٖ نٛظ

 . کاؼاکتؽ٘ای ِٛخٛظ ظؼ خؼثٗ ِتٕی ٔيؿ تٗ ِدّٛػٗ کاؼاکتؽ٘ای فٍم افؿٚظٖ ِی نٛٔع
  . ٘يچ کاؼاکتؽی خاقاؾی ٔطٛا٘ع نع Don’t Embed تا کٍيک تؽ ؼٚی

 
Selectable: 

 . فؼاي کؽظْ ایٓ گؿیٕٗ ِتٓ ظؼْٚ کاظؼ ؼا لاتً أتطاب ِی کٕع
 

 
 : تزای هشاهذه چگوًگی کاركارعولي؛
ظؼ . ؼا أتطاب کٕيع Test Movieگؿیٕٗ Control  ٔٛیَاؾ.ا فؼاي کٕيع ؼ Selectable تٕٛیكيع قپف ظکّٗ Stage ِتٕی ؼا ظؼ

ِتٓ لاتً أتطاب ،ٚ ُ٘ تا کهيعْ ِٛـ ؼٚی ِتٓ  Select All ٖ تاؾ نعٖ ُ٘ تا ؼاقت کٍيک کؽظْ ٚ أتطاب گؿیٕٗپٕدؽ
  . ؼا فؼاي ٔکؽظٖ تانيع ایٓ اِکاْ ٚخٛظ ٔطٛا٘ع ظانت Selectable ظؼ زاٌتی کٗ گؿیٕٗ. اقت 

 . ایٓ گؿیٕٗ ّ٘ٛاؼٖ فؼاي اقت Input Text ظؼ  :ٔىتٗ
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Line type: 
 

 Single line:ِتٓ ؼا تًٛؼت تک ضغی ّٔایم ِی ظ٘ع . 
Multiline:ِتٓ ؼا تًٛؼت چٕع ضغی ّٔایم ِی ظ٘ع . 

Multiline no wrap: ِتٓ تًٛؼت چٕع ضغی ّٔایم ظاظٖ ِی نٛظ اِا ِتٓ تٕٙا ظؼ ِسٍی
 . اقتفاظٖ نعٖ تانع Enter ِثً یتٗ ضظ تؼعی ِٕتمً ِی نٛظ کٗ اؾ کاؼاکتؽ٘ای

 
. 

 
Show border around text: 

  . تا فؼاي کؽظْ ایٓ ظکّٗ ِی تٛأيع زانيٗ ای ؼا ظؼ اعؽاف ِتٓ ایداظ کٕيع
Auto kern: 

نّا تٗ فٍم اخاؾٖ ِی ظ٘يع کٗ تًٛؼت ضٛظکاؼ فايٍٗ تيٓ زؽٚف ؼا  ،تا تيک ؾظْ ظؼ کاظؼ ایٓ لكّت 
 .تٕظيُ کٕع 

 
Maximum characters: 

تؼييٓ . کٗ کاؼتؽ ِی تٛأع ٚاؼظ کٕع ؼا تؼييٓ کٕيع ِی تٛأيع زعاکثؽ کاؼاکتؽ٘ائی  Input Text ظؼ
 . تيأگؽ ػعَ ِسعٚظیت ِی تانع يفؽ ػعظ

URL Link: 

اگؽ ایٓ لكّت ؼا ضاٌی ؼ٘ا کٕيع ِتٓ نّا تًٛؼت یک ِتٓ ِؼٌّٛی ّٔایم 
ِی تٛاْ  اِا اگؽ ظؼ ایٓ لكّت یک آظؼـ ایٕتؽٔتی تٕٛیكيع ِتٓ نّا تثعیً تٗ یک ٌيٕک ِی نٛظ ٚ. ظاظٖ ضٛا٘ع نع 

 . ؼٚی آْ کٍيک کؽظ
ظٚتاؼ کٍيک کٕيع تا ٚاؼظ زاٌت ٚیؽایهی  Static Text تٗ یک ِتٓ اتتعا تؽ ؼٚی ِتٓ اؾ ٔٛع URL تؽای افؿٚظْ یک آظؼـ یا

ٚ ظؼ  Properties زاي ظؼ پأً. کٕيع highlight ِتٓ نٛیع قپف تا ظؼگ ّٔٛظْ ِٛـ تطهی اؾ ِتٓ ظؼْٚ کاظؼ ؼا أتطاب ٚ

 . ؼـ ٚب قایتی ؼا کٗ ِی ضٛا٘يع تا کٍيک تؽ ؼٚی ایٓ تطم اؾ ِتٓ ٚاؼظ آْ نٛیع ٚاؼظ کٕيعآظ URL فيٍع
ِی تٛأيع  ،ظؼ يٛؼتی کٗ ِی ضٛا٘يع فؽَ ضايی اؾ پٕدؽٖ ؼا تٗ ػٕٛاْ ِمًع تؼييٓ کٕيع 

ّ٘چٕيٓ ِی تٛأيع تؼع اؾ أتطاب . ؼا أتطاب کٕيع  Target یکی اؾ گؿیٕٗ ٘ای ِٛخٛظ ظؼ کاظؼ
 . ؼٔگ ِٛؼظ ٔظؽتاْ ؼا أتطاب کٕيع Properties اؾ پاٌت ؼٔگ ظؼ پأً ،ٚاٖ ِتٓ ظٌص

 
 
 

 
 

Render text as HTML: 
تٛخٗ ظانتٗ . تٍمی ِی نٛظ HTML ِتٓ نّا تٗ ػٕٛاْ کع(غيؽ فؼاي اقت  Static Text تؽای)اگؽ ایٓ گؿیٕٗ ؼا فؼاي کٕيع  

 . ظؼا ٔعاؼ HTML تانيع کٗ فٍم لاتٍيت نٕاقائی تّاِی کع٘ای
Variable : 

تٗ . ٔاَ ِتغيؽی کٗ لؽاؼ اقت تٗ ِتٓ ِا ٔكثت ظاظٖ نٛظ ظؼ ایٓ لكّت ِی ٔٛیكيُ 

 Input تٛقظ ِتٓ ِا ّٔایم ظاظٖ ضٛا٘ع نع ٚ ظؼ ،٘ؽ ِمعاؼ کٗ ظؼ ِتغيؽ غضيؽٖ نعٖ تانع  ، Dynamic Text ایٓ تؽتية کٗ ظؼ
Text ،  قّم ؼا ظؼ تطم ِؽتٛعٗ ٔٛنتٗ ایُ غضيؽٖ ِی نٛظ ٚ تؼع لاتً ظؼ ِتغيؽی کٗ ا ،٘ؽ ِتٕی کٗ تٛقظ کاؼتؽ ٚاؼظ نٛظ

  . ّٔایم ِدعظ ضٛا٘ع تٛظ
 

 :تخع تىظيمات اتسار
فؼاي وؽظْ ظوّٗ آ٘ٓ ؼتا ظؼ تؽضي اتؿاؼتاػث قٌٙٛت لؽاؼگيؽي انياء ظؼ وٕاؼُ٘ ٚچفت نعْ آٔٙا تٗ يىعيگؽ 

گؽٖٚ نعٖ ؼقُ وؽظٖ ِٚأغ تلالي انىاي ؼاتٗ يٛؼت  Object Drawingظوّٗ .ٕ٘گاَ چيٕم انىاي ِي نٛظ
 .انىاي تايىعيگؽ ِي نٛظ

 :روگ آميسی در فيع 

ايداظ نية ؼٔگ ٚ ٔٛع قَٛ پؽوؽظْ نىً تايه : ؼٔگ آِيؿي قاظٖ ،ٔٛع ظَٚ:ٔٛع اٚي :ظؼفٍم قٗ ٔٛع ؼٔگ آِيؿي ٚخٛظ ظاؼظ:ٔىتٗ
 .تًٛيؽ اقت

ؼا Colorگؿيٕٗ  Windowٔٛي َاي ايداظ نية ؼٔگ اؾ تؽ.، تثعيً تعؼيدي يه ؼٔگ تٗ ؼٔگ ظيگؽ يا ِسٛنعْ آْ اقت شية رًگ
 .ؼا أتطاب ِي وٕيُ Typeٚقپف ِٕٛي 
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Solid:نىً ؼاتاؼٔگ يىٕٛاضت پؽِيىٕع. 

Linear:نية ؼٔگ ضغي ايداظ ِيىٕع. 

Radial:تاػث ايداظ نية ؼٔگ نؼاػي ِي نٛظ. 

Bitmap:نىً ؼا تايه ػىف ؼٔگ آِيؿي ِيىٕع. 

ؼاأتطاب ِيىٕيُ ،يه ٔٛاؼ ؼٔگي تاظٚظقتگيؽٖ  Radialيا  Linearٕ٘گاِي وٗ گؿيٕٗ 
ظا٘ؽ ِي نٛظ وٗ تاوٍيه وؽظْ ؼٚي ٘ؽظقتگيؽٖ ٚخاتٗ خاوؽظْ ػلاِت تؼلاٖٚ 

 .ؼٚي يفسٗ ؼٔگ ٘ا ،ِيتٛاْ ؼٔگ ٘اي تىاؼؼفتٗ ظؼ نية ؼٔگ ؼا تغييؽ ظاظ

 

 

 

 .نٛٔعاؼاقت وٍيه  وؽظْ ؼٚي يفسٗ ،ّٔاياْ ِيب Editظقتٛؼات ٚيؽايهي اؾِٕٛي : 1ٔىتٗ

اوثؽ تؽٔاِٗ ٘اي گؽافيىي ظاؼاي زافظٗ اي ٘كتٕع وٗ تاظ٘ٙا ػًّ لثٍي ؼا ظؼضٛظ زفظ وؽظٖ ٚظؼيٛؼت تّايً واؼتؽ،اِىاْ :2ٔىتٗ
 :ِكيؽ فؼاي قاؾي اْ.تؽگهت تٗ ػمة ؼا فؽاُ٘ ِيىٕٕع

Window > Other Panels > History 

 :چيذمان اغيا

  ظؼ ايٓ ٔؽَ افؿاؼ گفتٗ نع ٚزاي ٚلت آْ ؼقيعٖ وٗ تا ٔسٖٛ تؽوية انيا  ٚچيعِاْ آٔٙا تاوْٕٛ اتؿاؼ٘اي لاؾَ تؽاي عؽازي انىاي ِتٕٛع
 .،آنٕا نٛيُ 

  .ظؼاتتعاي أداَ ٘ؽ تؽٔاِٗ فٍم،ظؼضظ ؾِاْ تٕٙايه لايٗ ٚخٛظ ظاؼظٚ٘ؽنىٍي تؽؼٚي يفسٗ ؼقُ وٕيُ ظؼْٚ ايٓ لايٗ لؽاؼ ِيگيؽظ

 :لثً اؾ أداَ ٘ؽواؼ،تؼاؼيف ؾيؽ لاؾَ ِيّٕايع.ٔعي آنىاؼِي نٛظتا ؾياظنعْ تؼعاظ انىاي ظؼ تؽٔاِٗ ،ضؽٚؼت لايٗ ب

 لايٗ اي اقت وٗ واؼتؽ ؼٚي آْ وٍيه وؽظٖ ٚتٗ ؼٔگ آتي ظؼآِعٖ اقت ٚ ِٕتظؽ ايداظ تغييؽات ِي تانع:لايه فعال. 
 Stage Level :قغر يفسٗ وٗ انىاي ِٛخٛظ ظؼايٓ قغر تايىعيگؽ تؼاًِ ظاؼٔع. 
 Overlay Level : وٗ اخؿاي انياي ظؼْٚ ايٓ قغر تايىعيگؽ تؽوية نعٖ ٚظيگؽ تا قايؽ انيا تؼاًِ ٚتلالي قغر پٛنهي

 .ِتٓ ٘اظؼ ِسيظ فٍم ،ظؼايٓ قغر لؽاؼ ظاؼٔع.ٔعاؼٔع

 :ظؼ ِماتً ٔاَ ٘ؽلايٗ ،قٗ قتْٛ ٚخٛظ ظاؼظ.وٍيه وٕيُ Timelineتؽاي افؿٚظْ يه لايٗ خعيع وافيكت تؽؼٚي ػلاِت ظؼ پاييٓ تطم 

-Show or Hide all Layers   :، ْلايٗ ظٌطٛاٖ ؼا پٕٙاْ يا ٔٙاْ وؽظوٗ نثيٗ چهُ اقت ِٚيتٛاْ تاوّه آ. 

-Lock or Unlock all Layers  : ػلاِت ِهطًٗ ايٓ قتْٛ ،نىً لفً اقت ِٚيتٛاْ تٗ وّه آْ،لايٗ ِٛؼظ ٔظؽ ؼا لفً وؽظ 

 .اؼ تا لايٗ ٘اي ظيگؽ ظچاؼ تغييؽ ٔهٛظايٓ اِىاْ تاػث ِي نٛظ وٗ لايٗ ظؼزيٓ أداَ ن.يا اؾزاٌت لفً ظؼآٚؼظ

-  Show all Layers as OutLines  :تٗ وّه ايٓ اِىاْ ِيتٛاْ تّاَ انىاي ظاضً لايٗ ِٛؼظ ٔظؽ ؼا تؼييٓ وؽظ. 

 ؼا  show all layersآْ ،ٔاَ ،ٔٛع،اؼتفاع لايٗ ٚؼٔگ قتْٛ  (Properties)ظٚتاؼوٍيه وؽظْ تؽؼٚي اقُ لايٗ ِيتٛاْ ظؼ تطم تٕظيّات  تا

. تؽاي تغييؽ چيعِاْ لايٗ ٘ا ٔيؿ وافيكت تؽؼٚي لايٗ ِٛؼظ ٔظؽ وٍيه وؽظٖ ٚتٗ وّه ِٛـ آٔؽا أتماي ظاظ.تغييؽ ظاظ
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 :(Group)گرَي تىذي 

 :واؼتؽظ ػّعٖ ايٓ ظقتٛؼ ػثاؼتكت اؾ 

ِتٓ ٘ا ايٛلا ظؼ قغر اِا تؽضي ػٕايؽ ِإٔع .لؽاؼِيگيؽٔع (Stage Level)ظؼزاٌت ػاظي ،انيا ؼٚي يفسٗ ظؼ قغر يفسٗ .1
يىي اؾ ؼا٘ٙاي تثعيً انيا اؾ قغر يفسٗ تٗ قغر پٛنهي ،تثعيً آٔٙا تٗ گؽٖٚ اقت وٗ تؽاي ايٕىاؼ .پٛنهي لؽاؼ ظاؼٔع 

زاي اگؽ چٕع ني گؽٖٚ تٕعي نعٖ ؼا ظؼ يه لايٗ لؽاؼ .ؼاأتطاب وٕيُ Groupظقتٛؼ  Modifyوافيكت پف اؾ أتطاب نىً،اؾ ِٕٛي 
 .لغغ ّٔيىٕٕعظ٘يُ ظيگؽ ُ٘ ؼا 

چيعِاْ پيم ؼٚ 4ؼاأتطاب ٚيىي اؾ  Arrangeگؿيٕٗ  Modifyاگؽ تطٛا٘يُ چيعِاْ انىاي ؼا ٔكثت تٗ ُ٘ تغييؽ ظ٘يُ اؾ ِٕٛي 
 :ؼاأتطاب ِيىٕيُ

 Bring to Front:ني ؼا تٗ ؼٚي ّ٘ٗ انياي أتطاتي أتماي ِيع٘ع. 
 Bring Forward:ني ؼا تٗ يه قغر تالاتؽ ِٕتمً ِيىٕع. 
 Send Backward:ني ؼا تٗ يه قغر پاييٕتؽ أتماي ِيع٘ع. 
 Send to Back:ني ؼا تٗ ؾيؽ ّ٘ٗ انيا أتطاتي أتماي ِيع٘ع. 

 .واؼتؽظ ظيگؽ ايٓ ظقتٛؼ،ؾٔديؽ وؽظْ چٕع نىً تٗ ُ٘ ٚتغييؽ ظاظْ أعاؾٖ ٚ ِىاْ آٔٙا تا يىعيگؽ اقت .2

 تراز مردن اغيا

ؼاأتطاب ٚاؾ يفسٗ  Alignگؿيٕٗ  Modifyاؾِٕٛي وافيكت پف اؾ أتطاب آْ انيا ، تؽاي تؽاؾوؽظْ انيا ظؼ ِىاْ ِٕاقة ظؼ يفسٗ
 :تاؾنعٖ يىي اؾ ِعي ٘اي تؽاؾتٕعي ؼاأتطاب وٕيُ

 To stage :ٗأداَ تؽاؾ تٕعي ٔكثت تٗ يفس 
 Align:ٗتؽاؾتٕعي افمي ياػّٛظي انيا ٔكثت تٗ ٌثٗ ٘ا يا ٚقظ يفس 
 Match size:تٗ يىعيگؽ يىكاْ قاؾي اتؼاظ انيا ٔكثت 
 Space:تٕظيُ فايٍٗ انيا ٔكثت تٗ يىعيگؽ 

اگؽ تطٛا٘يُ چيٕم انيا تا ظلت تيهتؽي أداَ نٛظ ِيتٛأيُ اؾ ضظ وم اقتفاظٖ 
وٕيُ يا يفسٗ ؼا نغؽٔدي وٕيُ تؽاي فؼاي قاؾي ضظ وم يفسٗ ،اؾ ِٕٛي 

View ٕٗگؿيRulers  ْيفسٗ،اؾِٕٛي ؼا تيه ِيؿٔيُ ٚتؽاي نغؽٔدي وؽظView  ٕٗگؿي
Grid  ٕٗٚقپف گؿيshow Grid ُؼاتيه ظاؼ ِيىٕي. 

 :اوُاع فريم ٌا

 (frame)هعوولي فزين  -

 (Key frame)فزين كليذي -

 (Blank Key Frame)فزين كليذي خالي -

اقتفاظٖ ِيىٕيُ ٚتؽاي پان وؽظْ فؽيُ ٘ا ُ٘ پف اؾأتطاب فؽيُ  F5،F6 ٚF7تؽاي ايداظ فؽيُ ٘اي گفتٗ نعٖ تٗ تؽتية اؾوٍيع٘اي 
 .ؼافهاؼ ِيع٘يُ  Shift +F5ِٛؼظ ٔظؽ ،وٍيع٘اي 

ٔىتٗ لاتً غوؽظيگؽ ايٕىٗ فؽيُ ٘اي ِؼٌّٛي زاٚي نىً فؽيُ وٍيعي لثً اؾضٛظ ٘كتٕع ٚلاتً ٚيؽايم ّٔي تانٕع ٚاگؽ تطٛا٘يُ 
اضتياؼ ِالؽاؼ ِيع٘ع فؽيُ وٍيعي ضاٌي تٕٙا فؽيّي تؽاي ايداظ تغييؽ ظؼ.نىً أيّيهٓ تغييؽوٕع تايع اؾ فؽيُ وٍيعي اقتفاظٖ وٕيُ 

 .ٚاؾتٕظيّات فؽيُ وٍيعي لثٍي ضٛظ پيؽٚي ّٔيىٕع

 :َرَد تً دوياي اويميػه ضازي

 :اوُاع اويميػه ٌا

 .ايٓ ٔٛع اؾ أيّيهٓ ّ٘أگٛٔٗ وٗ اؾٔاَ آْ پيعاقت ،تأّايم ِتٛاٌي فؽيُ ٘ا ايداظ ِي نٛظ:تُاىي فريم ٌا -1

 :واؼػٍّي

تؽاي قاضت ايٓ ٔٛع أيّيهٓ وافيكت پف .يّيهٓ نّاؼٔعٖ ثأيٗ اقت اؾخٍّٗ أيّيهٓ ٘اي ؼايح اؾايٓ ٔٛع ،اْ
،ِماؼ قؽػت ،ظؼ لكّت تٕظيُ قؽػت ّٔايم أيّيهٓ  0ٚ أداَ تٕظيّات ؼٔگ ،أعاؾٖ ٚ تايپ ػعظ 1اؾوٍيه ظؼ فؽيُ 

تغييؽ  1ؼات0ٗؼافهاؼ ظ٘يُ ٚظؼ فؽيُ خعيع  F6وٍيه وؽظٖ ٚ 2آٔگاٖ ظؼ فؽيُ .وا٘م ظ٘يُ  1s(frame per second)ؼاتٗ 
 .ِيتٛاْ ٔتيدٗ واؼ ؼا ِها٘عٖ وؽظ Enter+Ctrlتافهؽظْ ّ٘ؿِاْ ظوّٗ ٘اي .تىؽاؼ وٕيُ  9ظ٘يُ ٚ ايٓ گاَ ٘ا ؼا تا ػعظ

 ؛تؼؽيف وُٕ ؼا Tweenوٗ ِياْ ياتي يا لاؾَ اقت ،لثً اؾايٕىٗ تفاٚت تيٓ أٛاع أيّيهٓ ٘اي ظيگؽؼاغوؽوُٕ 
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قُ وٕع ٚقاضت فؽيُ ٘اي فؽيُ ٘اي اتتعا ٚأتٙاي آْ ؼا ؼ ي يه زؽوت،ي تّاَ فؽيُ ٘ايؼٕي ايٕىٗ واؼتؽتٗ خاي عؽاذ هياًياتي
ِي تايكت وٍيٗ ي زاٌت ٘اي يه ني ؼا عؽاذ ضٛظل عؽازي وٕع، يؼٕي فؽيُ  ٖ فؽيُ بظؼ ؼٚل  .ِيأي ؼاتٗ تؽٔاِٗ تكپاؼظ

 .وٕعِمًع ؼا ِهطى ِي  فؽيُ ِثعا تا  فؽيُ ِكيؽ زؽوت ٚ تغييؽ نىً ازتّاٌي ني اؾ 

  :ايداظ وٕيُ فؽيُ تٗ  فؽيُِي ضٛا٘يُ زؽوت تؽگهت يه تٛپ تؼع اؾ تؽضٛؼظ تٗ ؾِيٓ ؼا تٗ وّه ؼٚل : ِثاي

 .يه يفسٗ ي خعيع واؼي ايداظ ِي وٕيُ File - new تا اخؽاي فؽِاْ-1
 .ِي گػاؼيُ bounce ٔاَ لايٗ ؼا -2
 .نىً تٛپ ؼا ؼقُ ِي وٕيُ bounce اؾ لايٗ 1ظؼ لاب  -3 
 10قپف تٛپ ؼا تٗ زاٌت أتطاب ظؼ ِي آٚؼيُ ٚ. ؼا ِي ؾٔيُ تا يه لاب وٍيعي خعيع ايداظ نٛظ F6اؾ ّ٘اْ لايٗ وٍيع 2لاب ظؼ  -4

 .ٚازع تٗ قّت پاييٓ ِٕتمً نٛظ 10ؼا ِي فهاؼيُ تا تٛپ تٗ أعاؾٖ ي ( زؽوت تٗ قّت پاييٓ) تا ؼ وٍيع خٙت ّٔاي پاييٓ
 .ٚازع تٛپ ؼا تٗ قّت تالا ِٕتمً ِي وٕيُ 9َ ٚ ايٓ تاؼ تٗ وّه وٍيع خٙت ّٔا تالا ؼا ِي ؾٔي F6 وٍيع 3ظٚتاؼٖ ظؼ لاب  -5
 .ٚازع تٗ قّت پاييٓ ِٕتمً ِي وٕيُ 8ؼا ِي ؾٔيُ ٚ تٛپ ؼا  F6 وٍيع 4ظؼ لاب  -6
 .ٚازع تٗ قّت تالا ِٕتمً ِي وٕيُ 7ؼا ِي ؾٔيُ ٚ تٛپ ؼا  F6 وٍيع 5ظؼ لاب  -7
 .تا ِؽزٍٗ ي پايأي يؼٕي ػعظ يه تؽقيُ( ظؼ ٘ؽ ِؽزٍٗ يه ٚازع وُ ِي نٛظ)اظاِٗ ِي ظ٘يُ  ؼٚٔع فٛق ؼا تٗ ّ٘يٓ تؽتية  -8
 .اقتفاظٖ ِي وٕيُ Ctrl+enter اؾ وٍيع ٘اي تؽويثي تؽاي ظيعْ ٔتيدٗ ي واؼ -9

2- Motion Tween (ِياْ ياتي زؽوتي): 

گؽافيىي ،ظوّٗ ٘ا ٚزتي ِتٓ ٘ا أداَ  ِيتٛأع ؼٚي وٍيپ ٘اي ٚيعئٛيي ،قّثً ٘اي  Motion Tweenِؼّٛلا أيّيهٓ 
نؽط اقتفاظٖ اؾ انيا ظؼ ايٓ ٔٛع .ٚيژگي ٘اي نيء ايداظ ِيّٕايعايٓ ٔٛع ِياْ ياتي ،ٚيژٖ تغييؽاتي اقت وٗ واؼتؽظؼ.گيؽظ

 .أيّيهٓ ،قّثً تٛظْ آٔٙا اقت

 Convert toظقتٛؼ Modifyاؾِٕٛی ،پف اؾأتطاب نىً ، تؽاي تثعيً يه ني تٗ قّثً
Symbolوٍيعا یF8   ؼافهاؼظاظٖ ٚاؾيفسٗ تاؾنعٖ ظؼلكّتName  ٔاَ ِٛؼظٔظؽقّثً ؼا ٚاؼظ

ٚٚاؼظ  قّثً نىً ِٛؼظٔظؽ تثعيً تٗ  زاي.ِيىٕيُ  okٔٛع قّثً ؼا أتطاب ٚ Type،ظؼلكّت 
 .اتطأٗ تؽٔاِٗ ِي نٛظوت

 :(Graphic Symbols)ضمثو گرافيکی

غکؽایٓ ٔکتٗ .یع ػٕايؽ ِٛخٛظ ظؼأيّيهٓ ؼاتٗ قّثً گؽافيکی تثعیً کؽظتؽای قاضت أيّيهٓ ٘ایی اؾٔٛع ِياْ یاتی کلاقيک تا
ضؽٚؼی اقت کٗ قّثً گؽافيکی ِيتٛأع ناًِ چٕعتطم یالایٗ تانع ِٚإٔع ؼقُ نکً ٘يچ ِسعٚظیتی اؾٔظؽ نيٖٛ عؽازی 

 .ٔعاؼظ

 :ِؿایای اقتفاظٖ اؾ قّثً گؽافيکی

 .یاظی ظؼ زدُ أيّيهٓ ٔٙایی ایداظ ّٔی نٛظتاافؿٚظْ ٘ؽتؼعاظ ّٔٛٔٗ اؾقّثً ظؼ پؽٚژٖ ، تغييؽؾ -

 (تغييؽ ؼٔگ،کا٘م ؼٚنٕایی،تغييؽ أعاؾٖ،کح کؽظْ ّٔٛٔٗ،کا٘م پٛنایی،چؽضأعْ ّٔٛٔٗ)ِيتٛاْ ّٔٛٔٗ ؼا تغييؽ ظاظ  -

 .تاتغييؽ قّثً ايٍی، ّٔٛٔٗ ٘ای تٗ کاؼؼفتٗ ظؼ پؽٚژٖ ٔيؿ تغييؽ ضٛإ٘ع کؽظ -

ؼؼفتٗ ظؼ کتاتطأٗ ،ؼٚی آیکْٛ کٕاؼٔاَ قّثً ظٚتاؼکٍيک ِيکٕيُ تازاٌت ٚیؽایهی فؼاي تؽای ٚیؽایم قّثً گؽافيکی تٗ کا: ٔکتٗ
 .تاظٚتاؼ کٍيک کؽظْ ؼٚی ٘ؽیک اؾّٔٛٔٗ ٘ای تکاؼؼفتٗ ظؼ پؽٚژٖ ٔيؿ ِيتٛاْ قّثً ايٍی ؼا ٚیؽایم کؽظ.نٛظ 

 :(Movie clip Symbols)ضمثو ٌای ومايػی 

قّثً .قّثً ّٔایهی ظؼٚالغ أيّيهٕی اقت کٗ ضظ ؾِاْ ِكتمً ظاؼظ ٚظؼضظ ؾِاْ پؽٚژٖ ايٍی ،ِيتٛأع ظؼیک فؽیُ اخؽا نٛظ
 .ّٔایهی ،یکی اؾپؽکاؼتؽظتؽیٓ أٛاع قّثً ٘ا ظؼ قاضت أيّيهٓ اقت چؽاکٗ اؾپيچيعگی ٚنٍٛغی ضظ ؾِاْ ِيکا٘ع 

 .تٛضير تيهتؽ ایٓ ٔٛع قّثً ظؼ أتٙای تسث أيّيهٓ

 :(Button Symbols)ضمثو ٌای دکمً ای 

یا ّ٘اْ ظکّٗ ٘ایی کٗ ظؼ قایت ٘ای ایٕتؽٔتی یا ٔؽَ افؿاؼ٘ای کاؼتؽظی تأؿظیک نعْ اناؼٖ  (Interaction)ظکّٗ ٘ای تؼاٍِی 
ظؼ .گؽِٛـ تغييؽ نکً یا تغييؽ ؼٔگ ِی ظٕ٘ع،ظؼفٍم خؿٚ قّثً ٘ای قٗ گأٗ ِی تانٕع

 :٘اؼفؽیّی ٚخٛظ ظاؼظ کٗ کاؼکؽظ ٘ؽیک ؼا تٛضير ِيعُِ٘سيظ قاضت ظکّٗ ،یک ضظ ؾِاْ چ

 .ایٓ فؽیُ ،نکً ظکّٗ ؼاظؼزاٌت ػاظی ٔهاْ ِيع٘ع:Upفؽیُ 

 .ٕ٘گاِی کٗ اناؼٖ گؽِٛـ ،ؼٚی ظکّٗ ِيؽٚظ،نکً ایٓ فؽیُ خایگؿیٓ لثٍی ِی نٛظ:Overفؽیُ 

 .تاکٍيک کؽظْ ؼٚی ایٓ ظکّٗ،ِستٛای ایٓ فؽیُ ظا٘ؽ ضٛا٘ع نع: Downفؽیُ 

ِسعٚظٖ ای کٗ اناؼٖ گؽ تاٚاؼظنعْ تٗ آْ ،تٗ نکً ظقت ظؼزاي اناؼٖ ظؼِی ایع ؼاتؼييٓ ِيکٕع ٚ نکٍی کٗ ظؼْٚ ایٓ :Hit فؽیُ
 .فؽیُ لؽاؼ ِيگيؽظ ،ظؼّٔایم ٔٙایی ظکّٗ ٔهاْ ظاظٖ ّٔی نٛظ
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 .یک ظکّٗ تكاؾیع کٗ ٕ٘گاَ ٔؿظیک نعْ اناؼٖ گؽ تٗ آْ،نکٍم تغييؽ کٕع: کاؼػٍّی 

 

 :ِيثانعؾیؽظؼ نم ِٛؼظ ٘ای گؽافيکی ٚ ّٔایهی  قّثً تغييؽ ٚيژگي ٘اي

 ِْىا( Position) 
 اتؼاظ(Scale) 

  وح نعگي(Skew) 
 چؽضم(Rotation) 
 ؼٔگ(Color) 
 فيٍتؽ(Filter) 

 : Motion Tweenوحُي ايجاد يل          

 .يه ظايؽٖ قاظٖ ؼااؾ قّت چپ يفسٗ تٗ قّت ؼاقت يفسٗ خاتٗ خا وٕيع: 1ثايَ

 :ِؽازً أداَ واؼ

ؼٚي قّثً  Motionٔىتٗ اي وٗ تايع ظؼٔظؽ تگيؽيُ ايٓ اقت وٗ .قّت چپ يفسٗ يه ظايؽٖ تؽقيُ ِيىٕيُ ق Stageظؼ  .1
 .پف لاؾَ اقت ني ؼا لثً اؾ اقتفاظٖ تٗ عؽيمي وٗ ظؼ تالا غوؽ نع ، تٗ قّثً تثعيً وٕيُ .٘اي گؽافيىي ػًّ ِيىٕع 

 .تاقّثً ظؼايٓ فؽيُ وپي نٛظ ؼا فهاؼ ِيع٘يُ F5وٍيه ِي وٕيُ ٚ وٍيع  30ظؼ فؽيُ  .2
آتي  30تا1تافؽيُ ٘اي ؼا اخؽا ِيىٕيُ   Create Motion Tweenظؼ يىي اؾ فؽيُ ٘اي ِيأي وٍيه ؼاقت وؽظٖ ٚگؿيٕٗ  .3

 .نٛٔع

ِٛلؼيت ظايؽٖ ؼا تٗ قّت ؼاقت يفسٗ تغييؽ ِيع٘يُ يه ِكيؽ زؽوت تؽاي  Stageوٍيه وؽظٖ ٚظؼ ( 30فؽيُ )ظؼفؽيُ آضؽ  .4
 .يّيهٓ ايداظ ِي نٛظتٕظيُ زؽوت اْ

 .ِيتٛاْ ٔتيدٗ واؼ ؼا ِها٘عٖ وؽظ Enterتاؾظْ  .5

 

 :Motion Tweenتغيير َيژگيٍاي يل 

 

تؽاي تغييؽ اتؼاظ . تغييؽ ظؼ نىً ِكيؽ زؽوت قّثً تا ظقتىاؼي ِكيؽ زؽوت ّٔايم ظاظٖ نعٖ ظؼ ِثاي تالا لاتً أداَ اقت  
قتفاظٖ اؾ اتؿاؼ تغييؽ نىً ٔيؿ ِيتٛاْ تغييؽات ظيگؽي ِثً وح وؽظْ قّثً يا چؽضأعْ تاا.ُ٘ اؾ اتؿاؼ تغييؽ أعاؾٖ اقتفاظٖ ِيىٕيُ 

 .آْ ؼا اػّاي وؽظ

 :تؽاي تغييؽات زؽفٗ اي تؽ ، ؼٚي يىي اؾ فؽيُ ٘اي ِيأي وٍيه وؽظٖ ٚظؼ لاب تٕظيّات تغييؽات ؼا تٕا تٗ ظٌطٛاٖ اػّاي ِيىٕيُ 

 Ease : شتاب حزكت 
-Ease In(-100)   :ْيّيهٓ اؾ وٕع تٗ تٕعقؽػت ا 

 
-Ease Out(100) :قؽػت أيّيهٓ اؾ تٕع تٗ وٕع 
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 Rotate : ْتؼييٓ تؼعاظ ظفؼات چؽضم قّثً لثً اؾ ؼقيعْ تٗ ِمًع ٚ تا تغييؽ ؾاٚيٗ چؽضم ،خٙت لؽاؼ گيؽي ٔٙايي آ

 .ؼا ٔكثت تٗ زاٌت اٌٚيٗ ِهطى ِيىٕيُ

 
 Direction :خٙت زؽوت 

 
-CW  :قاػت  چؽضم ظؼ خٙت ػمؽتٗ ٘اي 
-CCW : چؽضم ضلاف خٙت ػمؽتٗ اي قاػت 
 

 Orient to path  : زؽوت تؽِكيؽ ِٕسٕي 
ظؼ ِكيؽ٘اي ِٕسٕي اگؽ تغييؽ خٙت ٔيؿ ظانتٗ تانيُ ، تؽاي ايٕىٗ زؽوت ػًٕؽ ظؼ ِكيؽ ِٛؼظ ٔظؽ ،عثيؼي تؽ تٗ ٔظؽ 

 .ٔٗ اقت پف اؾ تيه ايٓ گؿي Timelineنىً ؾيؽ ّٔاي .ؼقع ، ايٓ گؿيٕٗ ؼا تيه ظاؼ ِيىٕٕع

 

 :Motion Editorآغىايي تا پىجري 

 

ؼافؼاي وٕيع ،تٕظيّات   Motion Editorؾتأٗ  Timelineچٕأچٗ ؼٚي يىي اؾ فؽيُ ٘اي أيّيهٓ قاضتٗ نعٖ وٍيه وؽظٖ ٚظؼلاب 
 .ِتؼعظ ٚ ظليمي تؽاي واؼتؽؼٚي ته ته فؽيُ ٘ا ظؼ اضتياؼ نّا لؽاؼ ضٛا٘ع گؽفت

 وحُي رخيري اويميػه 

اِا اگؽ تطٛا٘يُ آٔؽا ظؼ .ؼااخؽا ٚآٔؽا ظؼ ِكيؽ ظٌطٛاٖ ،غضيؽٖ ِيىٕيُ  Save Asگؿيٕٗ  Fileاؾِٕٛي  CS4غضيؽٖ أيّيهٓ تافؽِت  تؽاي
ظؼ ٔكطٗ ٘اي پاييٓ پهتيثأي ّٔي نٛظ ،ػّلا ايٕىاؼ ِّىٓ  Motion Tweenغضيؽٖ وٕيُ ،تٗ ظٌيً ايٕىٗ  CS3فؽِت پاييٓ تؽ ِثً 

  Convert Frame By Frame Animationوٍيه ؼاقت وؽظٖ ٚتا گؿيٕٗ  Timelineٌٗ تٗ لثً تؽگؽظيع ظؼ ٔيكت پف ٔياؾ اقت يه ِؽذ
 .ؼا اخؽا وٕيع CS3آٔؽا تٗ أيّيهٓ فؽيُ تٗ فؽيُ تثعيً ٚ ِؽازً غضيؽٖ تا پكٛٔع 

 :Motion Presetغضيؽٖ اعلاػات أيّيهٓ تا 

ا غضيؽٖ ٚ آْ ؼا ؼٚي قايؽ ػٕايؽ اػّاي تا ايٓ اِىاْ ، ِيتٛاْ زؽوات قاضتٗ نعٖ ظؼ يه پؽٚژٖ ؼ
ؼا  Save As Motion Presetتؽاي ايٕىاؼ ؼٚي يىي اؾ فؽيُ ٘اي ِيأي وٍيه ؼاقت وؽظٖ ٚ .ّٔٛظ

 .ظؼ پٕدؽٖ تاؾ نعٖ ٔاِي تؽاي زؽوت أتطاب ِيىٕيُ .اخؽا ِيىٕيُ 

ااؾ ِٕٛي ؼ  Motion Preset،پٕدؽٖ غضيؽٖ نعٖ ؼٚي ػًٕؽ خعيع   Motion Presetتؽاي اػّاي 
Window   ٗتاؾ وؽظٖ ، زؽوت غضيؽٖ نعٖ ؼا اؾپٛنCustom Presets   ٚ أتطابApply   ُِيىٕي . 

   3-   Classic Tween(ميان ياتي ملاضيل): 

تاايٓ ؼٚل أيّيهٓ قاؾي ِيتٛاْ خاتٗ خايي ، چؽضم ،تغييؽ أعاؾٖ ٚ تغييؽ ؼٔگ 
قاؾي تيٓ ظٚ فؽيُ وٍيعي أداَ  ، ايٓ أيّيهٓ  Motion Tweenتؽضلاف .ؼاأداَ ظاظ 

 .ِي نٛظ

 .أداَ ظ٘يع  Classic Tweenِثاي لثً ؼا تا اقتفاظٖ اؾ 

 :ِؽازً أداَ واؼ  

 .آٔؽا تٗ قّثً تثعيً ِيىٕيُ  F8يفسٗ اي خعيع تاؾ ٚظؼآْ ظايؽٖ اي ؼقُ ٚتااقتفاظٖ اؾ وٍيع .1 
 .يٓ فؽيُ وپي نٛظؼاِيؿٔيُ تانىً ظؼ ا F6وٍيه وؽظٖ ٚ وٍيع  30زاي ؼٚي فؽيُ .2
 .ؼاِيؿٔيُ  Create Classic Tweenؼاقت وٍيه وؽظٖ ٚگؿيٕٗ  1ؼٚي فؽيُ .3

ٔيؿ أداَ ِيع٘يُ تافؽيُ ٘اتٕفم نٛٔع ٚپيىأي تٗ ٔهاْ ايداظ أيّيهٕي ولاقيه ظا٘ؽ  30اتؽؼٚي فؽيُ ّ٘يٕىاؼؼ.4
 .نٛظ
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يٓ تاوٍيه تؽؼٚي نىً ،ِيتٛاْ اؾ لاب تٕظيّات ّ٘چٓ.وٍيه وؽظٖ ٚ خايگاٖ نىً ؼا تغييؽ ِيع٘يُ 30ؼٚي فؽيُ نّاؼٖ .5
 .اػّاي وؽظ... ،تغييؽات ظٌطٛا٘ي ِإٔع تغييؽ ؼٔگ ، ؼٚنٕايي ٚ

 .، ٔتيدٗ ؼا ِها٘عٖ ِيىٕيُ Ctrl+Enterتافهاؼظاظْ وٍيع٘اي .6

 
 

 :Classic Tweenتا   Motion Tweenتفاَت ٌاي 

ِيتٛإٔع ِتاٚت ٔيؿ تانٕع اِا ظؼ ِياْ ياتي زؽوتي ، تٕٙا اؾ  ظؼ ِيأياتي ولاقيه ، اؾ ظٚ قّثً اقتفاظٖ ِي نٛظ وٗ.1
 .يه قّثً اقتفاظٖ ِي نٛظ

 .ظؼ ِياْ ياتي زؽوتي ، اخاؾٖ وعٔٛيكي ٔعاؼيُ.2
 .اؾ ِيأياتي ولاقيه ، ّٔيتٛاْ تؽاي ايداظ أيّيهٓ ٘اي قٗ تؼعي اقتفاظٖ وؽظ.3
تٗ يٛؼت ّ٘ؿِاْ ِداؾ اقت اِا ظؼ ِياْ ياتي زؽوتي ايٓ  ظؼ ِيأياتي ولاقيه ، اػّاي تيم اؾ ظٚٔٛع تٕظيُ ؼٔگ ،.4

 .اخاؾٖ ؼا ٔعاؼيُ 

 :امکان ايجاد لايً راٌىما 

ِستٛیات ایٓ لایٗ ظؼ .اقتفاظٖ ِيکٕٕع( Layer Guide)تؽای ایٕکٗ أيّيهٓ ظؼ ِكيؽ اؾ پيم تؼييٓ نعٖ ای زؽکت کٕع اؾلایٗ ؼإّ٘ا
ّٕ٘ا ، پف اؾایداظ لایٗ أيّيهٓ ِٛؼظ ٔظؽ ،یک لایٗ خعیع ایداظ ٚ ؼٚی آْ ؼاقت تؽای ایداظ یک لایٗ ؼا.ضؽٚخی ِها٘عٖ ّٔی نٛظ

ظؼ فؽیُ اٚي کٍيک کؽظٖ ِٚكيؽ ِٛؼظ ٔظؽ ؼا (یک ػلاِت چکم ظؼکٕاؼ آْ ظا٘ؽ ِی نٛظ. )ؼاأتطاب ِيکٕيُ Guideکٍيک ٚگؿیٕٗ 
تؽؼٚی لایٗ أيّيهٓ کٍيک کؽظٖ ٚ أيّيهٓ  .(نٛظ ػلاِت ظٔثاٌٗ ظاؼ ظؼکٕاؼآْ ظا٘ؽ ِی.)ؼقُ ٚلایٗ پایيٓ ؼا ؼٚی آْ ظؼگ ِيکٕيُ

 .ؼا تؽ ِكيؽ زؽکت ِٕغثك ِيکٕيُ

 

4- Shape Tween(ِياْ ياتي نىٍي) 

 

ظؼایٓ قثک اؾأيّيهٓ ٔيؿظٚفؽیُ کٍيعی ٚخٛظ ظاؼظ،تاایٓ تفاٚت کٗ ظؼِكيؽ 
ایٓ قثک تٗ خای  Motion Tween،ِٕدؽتٗ تغييؽ یک نکً تٗ نکً ظیگؽ ِی نٛظٚتؽضلاف  Tweenتيٓ ظٚفؽیُ ػٍّيات 

 .اقت Morphٔاَ ظیگؽ ایٓ ٔٛع أيّيهٓ .قّثً ٘اؼٚی ضٛظ اخكاَ تٗ أداَ ػٍّيات ِی پؽظاؾظ

 .یک ِؽتغ ؼاتٗ ظایؽٖ تثعیً کٕيع Shape Tweeningتااقتفاظٖ اؾ : ِثاي

 .ظؼ فؽیُ اٚي یک ِؽتغ ؼقُ ِيکٕيُ-1
 .ؼاِيؿٔيُ ٚ یک ظایؽٖ ِيکهيُ F7کٍيک کؽظٖ ٚ 30ظؼ فؽیُ -2
 .ظایؽٖ ؼا تؽ ِکاْ ِؽتغ ِٕغثك ِيکٕيُ Onion Skinتااقتفاظٖ اؾ اِکاْ  -3
 .ؼااخؽا ِيکٕيُ Create Shape Tweenظؼ یکی اؾ فؽیُ ٘ای ِيأی ؼاقت کٍيک کؽظٖ ٚگؿیٕٗ  -4

Shape Tweening  تررَی تصاَير گرافيکی: 

 .تاایٕکاؼ ، یک تًٛیؽ ؼا تٗ تًٛیؽ ظیگؽ تثعیً ِيکٕيُ

 : ِؽازً أداَ کاؼ
أتماي  Stageتٗ  gifؼاظٔثاي ٚیک تًٛیؽ تاپكٛٔع  File > Import>Import to stageکٍيک کؽظٖ ٚ ِكيؽ 1ظؼ فؽیُ .1

 .ِيع٘يُ
 .ؼااخؽا ِيکٕيُ تاتًٛیؽ اؾؾِيٕٗ خعا گؽظظ  Brake Apartؼٚی تًٛیؽ ؼاقت کٍيک کؽظٖ ٚظقتٛؼ. 2

ؼٚی ؾِيٕٗ تًٛیؽ أتطاب ٚآٔؽا زػف ِيکٕيُ Magic Wandٚأتطاب  ایٓ اتؿاؼ Optionٚتؼع اؾتطم  Lassoتااقتفاظٖ اؾ اتؿاؼ .3
. 
 .ایداظ ِيکٕيُ Blank KeyFrameیک F7ؼفتٗ ٚتاؾظْ کٍيع  30تؽؼٚی فؽیُ .4
 .ِيکٕيُاضافٗ کؽظٖ ٚ ؾِيٕٗ آٔؽا زػف  Stageتًٛیؽی ظیگؽ ؼا عثك ِؽازً تالا تٗ .5
ػًّ تثعیً  Enterتاؾظْ .ؼااخؽا ِيکٕيُ   Create Shape Tweenظؼیکی اؾ فؽیُ ٘ای ِيأی کٍيک ؼاقت کؽظٖ ٚ گؿیٕٗ .6

 .یک تًٛیؽ تٗ تًٛیؽ ظیگؽ يٛؼت ِيگيؽظ

Shape Hint (وقاط کىترىی تغيير غکو اغياء:) 

ٔماط کٕتؽٌی ، تاتثعیً ٔماط ِتٕاظؽ تٗ ُ٘ ظؼ ظٚفؽیُ کٍيعی ِتفاٚت ،تاػث 
تؽای .گؽظٔعِی  Shape Tweeningایداظ تغييؽ نکً ٘ای ِتٕاقثی ظؼ ػًّ 

اضافٗ کؽظْ ٔماط کٕتؽٌی ظؼ ػًّ ایداظ أيّيهٓ ٘ای نکٍی ، ِكيؽ 
Modify> shape>Add shape Hint   ُایٓ ػًّ ظؼ فؽیُ . ؼا ظٔثاي ِيکٕي

أداَ ِی نٛظ ٚظؼٔتيدٗ ٔماط ( تٛظ 30کٗ ظؼ ِثاي تالا فؽیُ )٘ای اٚي ٚآضؽ
یكت ایٓ ٔماط تؽای تغييؽ نکً ؼٚی نکً اضافٗ ِی گؽظظ تٕٙا کافکٕتؽٌی 

ایٓ ٔماط کٕتؽٌی ظؼ .ؼا تا خاتٗ خایی ظؼ ِسً ِٛؼظ ٔظؽ ؼٚی نکً ظؼگ کٕيع



Flash Cs4 Learning  

 Page 18 آمىزشگاه اسپيرال 
 

 تيضی  تٗٔماط کٕتؽٌی أيّيهٓ تثعیً ػعظ ِؽتغ  تؽای ّٔٛٔٗ ظؼ ؾیؽ.فؽیُ اٚي تٗ ؼٔگ ؾؼظ ٚظؼ فؽیُ أتٙایی تٗ ؼٔگ قثؿ ِی تانٕع 
  . ِها٘عٖ ِيکٕيعؼا 

 :کييپ ٌای تُدرتُ ضاخت

ٔٛع ضايی اؾ قّثً ٘اقت کٗ اؾاْ تؽای قاضت أيّيهٓ ٘ای  Movie Clipؼ تسث ِؽتٛط تٗ قّثً ٘ا گفتيُ ،ّ٘أگٛٔٗ کٗ ظ
تؽای ِثاي فؽٌ کٕيع تطٛا٘يُ یک آقّاْ پؽقتاؼٖ ؼا کٗ قتاؼٖ ٘ای آْ ظؼ زاي .تٛظؼتٛ ٚظکّٗ ٘ای ِتسؽک اقتفاظٖ ِی نٛظ

عؽازی . ف ظیگؽ یا زؽکت یک ِانيٓ ؼا ظؼ خاظٖ عؽازی کٕيُ قٛقٛ ؾظْ ِيثانٕع یا زؽکت یک پؽٚأٗ اؾ یک عؽف يفسٗ تٗ عؽ
٘ؽیک اؾ ایٓ ٘ا تعْٚ کّک گؽفتٓ اؾ قّثً گؽافيکی ، ٔياؾ تٗ اقتفاظٖ اؾ لایٗ ٘اٚفؽیُ ٘ای فؽاٚاْ ظاؼظ کٗ ِعیؽیت لایٗ ٘ا ؼا 

 .قطت ِيکٕع 

 .زاي تؽای ظؼک تٙتؽ نؽٚع تٗ عؽازی آقّاْ پؽقتاؼٖ ِيکٕيُ 

 :ِؽازً أداَ کاؼ
 .یک پؽٚژٖ خعیع ایداظ ِيکٕيُ-1
 .أتطاب ِيکٕيُ Movie Clipٚ ٔٛع آٔؽا  New Symbolگؿیٕٗ  Insertاؾِٕٛی -2
 .تؼييٓ ِيکٕيُ Starؼاأتطاب ٚ قپف ٔٛع چٕع ضٍؼی ؼا  PolyStar Toolsاؾ ِٕٛی اتؿاؼ ،-3
کّؽٔگ )ؾظْ قتاؼٖ ؼا أداَ ِيع٘يُ  ؼا ِيؿٔيُ ٚ اؾ تطم تٕظيّات ، تٕظيّات لاؾَ تؽای قٛقٛ F6ظؼ فؽیُ ظَٚ ، کٍيع -4

 (کؽظْ زانيٗ ظٚؼ یا ٘ؽٔٛع تٕظيّی کٗ تٙتؽ ِيعٚٔيٓ
 .کپی ِيکٕيُ 4ٚ 3ؼا ظؼ فؽیُ ٘ای  1ٚ2فؽیُ ٘ای  -5
 .ٔتيدٗ کاؼ ؼاغضيؽٖ ِيکٕيُ -6
 .ؼااؾتالای يفسٗ أتطاب ٚٚاؼظ يفسٗ ايٍی قاضت أيّيهٓ ِی نٛیُ   Scene 1گؿیٕٗ  -7
ِيتٛأيُ تااتؿاؼ .تٗ يفسٗ ظؼگ ِيکٕيُ Libraryٖ قياٖ تغييؽ ِيع٘يُ ٚ ٘ؽتؼعاظ قتاؼٖ اؾ پًٕ ؼا ب  Stageؼٔگ  -8

FreeTransform ُتغييؽات ظٌطٛا٘ی ؼٚی قتاؼٖ ٘ا اػّاي کٕي. 
 .ؼا تؿٔيع Ctrl +Enterتؽای ظیعْ ٔتيدٗ کاؼ  -9

 :  Maskتُاوايی کار تالايً 

ػث ّٔایم تطهی اؾ ػٕايؽ ِٛخٛظ ظؼ يفسٗ ٚ ِطفی نعْ ػٕايؽ ظیگؽی ِاقک پٛنهی اقت کٗ ؼٚی يفسٗ لؽاؼ گؽفتٗ ٚتا 
 .ظؼٚالغ ِاقک ٘ا ّ٘يهٗ لایٗ ؾیؽیٓ ضٛظ ؼا تست تاثيؽ لؽاؼ ِيعٕ٘ع.اؾ يفسٗ ِی نٛظ 

 :ضاخت ماضک ثاتت-اٌف

 :ِؽازً أداَ کاؼ

 .یک فایً خعیع ایداظ ِيکٕيُ -1
 .ظؼ لایٗ خعیع یک تًٛیؽ اضافٗ ِيکٕيُ -2
 .لؽاؼ ِيع٘يُ Maskیکٕيُ ٚ ٔاَ آٔؽا لایٗ خعیعی ایداظ َ -3
 .ظؼ ایٓ لایٗ تًٛیؽ ،ِتٓ یا نکٍی کٗ ِيطٛا٘يُ تٗ ػٕٛاْ پٛنم ِٛؼظ اقتفاظٖ لؽاؼ گيؽظ ؼا اضافٗ ِيکٕيُ -4
 .ؼا ِيؿٔيُ  Maskؼٚی ایٓ لایٗ ؼاقت کٍيک کؽظٖ ٚ گؿیٕٗ  -5
ت کٗ پٛنم ؼٚی آْ ایداظ نعٖ ِها٘عٖ ضٛا٘يُ کؽظ کٗ پٛنم ایداظ نعٖ زاٚی لكّت ٘ایی اؾ تًٛیؽ لایٗ اٚي اـ -6

 .اقت

 : ضاخت ماضک متحرک -ب

 :Classic Tweenماضک متحرک تااضتفادي از : اٌف-ب

 :ؼا ایداظ ِيکٕيُ Spotlightتؽای آِٛؾل ایٓ ٔٛع ِاقک ،ِثاي زؽکت ٔٛؼ ؼٚی يفسٗ یا  

 :ِؽازً أداَ کاؼ

 .یک فایً خعیع ایداظ ِيکٕيُ -1
 ؼٔگ ؾِيٕٗ ؼا تيؽٖ أتطاب ِيکٕيُ  -2
 .ااقتفاظٖ اؾ اتؿاؼ ِتٓ ، ِتٕی ؼا ؼٚی ؾِيٕٗ ایداظ ِکيٕيُ تٗ عٛؼیکٗ کً پٕٙای ؾِيٕٗ ؼا تپٛنأعب -3
 .ؼاِيؿٔيُ F5ایٓ لایٗ کٍيک ٚ کٍيع  30ظؼ فؽیُ  -4
 .ٚظؼ فؽیُ اٚي آْ ،یک ظایؽٖ ظؼ قّت چپ ِتٓ ؼقُ ِيکٕيُ Maskلایٗ خعیعی ایداظ ٚٔاَ آٔؽا  -5
 .ظ ٚ ظایؽٖ ؼا تٗ قّت ؼاقت يفسٗ أتماي ِيع٘يُ ،یک فؽیُ کٍيعی ايٍی ایدا 30ظؼ فؽیُ  -6
 .ؼاأتطاب ِيکٕيُ  Maskتؽؼٚی لایٗ ؼاقت کٍيک کؽظٖ ٚ گؿیٕٗ  -7
 .ؼا أتطاب ِيکٕيُ Create Classic Tweenتؽؼٚی یکی اؾ فؽیُ ٘ای ِيأی لایٗ ِاقک ، ؼاقت کٍيک کؽظٖ ٚگؿیٕٗ  -8
چپ تٗ ؼاقت يفسٗ ّٚٔایم ِتٓ زيٓ زؽکت اقت ؼا  ٔتيدٗ کاؼ ؼا کٗ زؽکت ظایؽٖ اؾ قّت Ctrl + Enterتاؾظْ  -9

 .ِها٘عٖ ِيکٕيُ

 :Shape Tweenماضک متحرک تااضتفادي از : ب-ب
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 .تااقتفاظٖ اؾایٓ ٔٛع ِاقک ، ِا ِيتٛأيُ ِتٓ ؼا تٗ تعؼیح ؼٚی يفسٗ ّٔایم ظ٘يُ 

 :ِؽازً أداَ کاؼ

 .تغييؽ ٔاَ ِيع٘يُ" ِتٓ "فایً خعیعی ایداظ ٚلایٗ اٚي ؼا تٗ  -1
 .ٚی فؽیُ اٚي لایٗ ِتٓ کٍيک کؽظٖ ِٚتٓ ظٌطٛاٖ ؼاتااقتفاظٖ اؾ اتؿاؼ ِتٓ ، ِيٕٛیكيُتؽؼ -2
 .ایداظ نٛظ 1ؼا فهاؼ ِيع٘يُ تا کپی اؾ فؽیُ  F5کٍيک کؽظٖ ٚکٍيع  40تؽؼٚی فؽیُ  -3
ِيکٕيُ  لؽاؼ ِيع٘يُ ٚظؼایٓ لایٗ تااقتفاظٖ اؾ اتؿاؼ ؼقُ نکً ، ِكتغيٍی ؼقُ" پٛنم"لایٗ خعیعی ایداظ ٚٔاَ آْ ؼا  -4

 .کٗ اؼتفاع آْ تٗ أعاؾٖ اؼتفاع ِتٓ تانع

 

ِكتغيً ؼا عٛؼی  أعاؾٖ    FreeTransform ؼا ِيؿٔيُ ٚظؼایٓ فؽیُ تااقتفاظٖ اؾ اتؿاؼ  F6کٍيک کؽظٖ ٚ کٍيع  40تؽؼٚی فؽیُ  -5
 .تغييؽ ِيع٘يُ کٗ کً ِتٓ ؼا تپٛنأع

 
ؼا  Maskتؽؼٚی ایٓ لایٗ ؼاقت کٍيک کؽظٖ گؿیٕٗ  -6
 .ِيؿٔيُ
ٚی یکی اؾ فؽیُ ٘ای ِيأی لایٗ پٛنم ؼاقت تؽؼ -7

 .ؼا ِيؿٔيُ Create Shape Tweenکٍيک کؽظٖ ٚگؿیٕٗ 
  Ctrl+Enterتؽای ظیعْ ٔتيدٗ کاؼ  -8

 

 :غکؽچٕع ٔکتٗ

ظؼٕ٘گاَ ایداظ ِاقک ،آیکٓ ٔاَ لایٗ ٘ا ظؼ لایٗ ِاقک ٚ لایٗ ِاقک نعٖ تغييؽ نکً ِيع٘ع ٚ لایٗ ِاقک نعٖ تٗ يٛؼت -
 .ِاقک ظؼآِعٖ ٚایٓ یؼٕی ایٓ لایٗ تست تاثيؽ لایٗ تالایی لؽاؼ گؽفتٗ اقت ؾیؽِدّٛػٗ لایٗ

تؽای .لایٗ ِاقک ٚ ِاقک نعٖ تٗ زاٌت غيؽلاتً ٚیؽایم یا لفً نعٖ ظؼ ِی آیٕع-

اػّاي تغييؽات ؼٚی لایٗ ِاقک ، آٔؽا اؾ زاٌت لفً ضاؼج کؽظٖ ،قپف تغييؽات ِٛؼظ 
 .یٗ ِاقک ٚ لایٗ ِاقک نعٖ ؼا لفً کٕيعٔظؽ ؼاظؼایٓ لایٗ اػّاي کؽظٖ ، ظٚتاؼٖ لا

 .انکاٌی کٗ تٗ ػٕٛاْ ِاقک ظؼایٓ لایٗ لؽاؼ ِيگيؽٔع، ؼٔگ ظٚؼ ضظ ٚزتی عيف ؼٔگ آٔٙا ٘يچ تاثيؽی ظؼ ِاقک ٔعاؼظ -

 :Rolloverتکىيک 

ایٓ ؼٚل .ی نٛظتااقتفاظٖ اؾایٓ تکٕيک ،تالؽاؼگؽفتٓ اناؼٖ گؽ ِٛـ ؼٚی ظکّٗ ، یک ِتٓ یاتًٛیؽ کّکی ظؼ اعؽاف آْ ظا٘ؽ َ
 .ؼٚی ِتْٛ یا تًاٚیؽ ٔيؿ اقتفاظٖ کؽظ(Tooltip)تٕٙا تٗ ظکّٗ ٘ا ضتُ ّٔی نٛظ تٍکٗ ِی تٛاْ اؾآٔٙا تؽای لؽاؼظاظْ ؼإّ٘ا 

 :ِؽازً أداَ کاؼ

 :ِكيؽ ؾیؽ ؼا عی ِيکٕيُ  -1
Insert> New Symbol > Name:Tooltip >type: Button>ok 

 .کاؼی ٔعاؼیُ  Up  ٚDownتٗ فؽیُ ٘ای  -2
 .ؼا ِيؿٔيُ ٚ یک فؽیُ کٍيعی ضاٌی ایداظ ِيکٕيُ F7کٍيک کؽظٖ ،کٍيع   Hitظؼ فؽیُ  -3
 .تااقتفاظٖ اؾ اتؿاؼ ؼقُ نکً ، یک ِسعٚظٖ ای تؽای ّٔایم ؼإّ٘ا ایداظ ِيکٕيُ -4
ؼظ ِيتٛاْ ِسعٚظٖ ِٛ Onion Skinتااقتفاظٖ اؾ لاتٍيت .ؼفتٗ ٚ ِتٓ ؼإّ٘ا ؼا ظؼ ایٓ ِسعٚظٖ ِيٕٛیكيُ  Overتٗ فؽیُ  -5

 .ٔظؽ ؼا تؽای تغاتك ِتٓ ظیع

 
( تًٛیؽ ، ظکّٗ ، ِتٓ)تؽِيگؽظیُ ٚ اؾ پًٕ کتاتطأٗ ، ایٓ ؼإّ٘ای ایداظ نعٖ ؼا تٗ لكّت ِٛؼظ ٔظؽ  Scence1تٗ  -6

 .اضافٗ ِيکٕيُ

  :ضاخت دکمً متحرک

تٗ خای یک نکً Downیا  Up،Overٔسٖٛ قاضت ایٓ ظکّٗ ٘ا ٔيؿ ِإٔع قایؽ ظکّٗ ٘ااقت تاایٓ تفاٚت کٗ ظؼ فؽیُ ٘ای 
ٔکتٗ لاتً تٛخٗ آٔکٗ چْٛ ظؼ ٘ؽقٗ زاٌت ،ِافمظ تایک فؽیُ قؽٚکاؼ ظاؼیُ ،لاؾَ اقت .ثاتت اؾیک أيّيهٓ اقتفاظٖ ِيهٛظ

 .قاضتٗ ٚقپف تٗ فؽیُ ِٛؼظ ٔظؽ ظؼظکّٗ أتماي یاتع Movie Clipاتتعا أيّيهٓ ؼا ظؼیک 

 :ِؽازً أداَ کاؼ

 .یک فایً خعیع ایداظ کٕيع-1
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 .کٕيع Insert" ظکّٗ"قّثً اؾ ٔٛع أيّيهٓ تا ٔاَ یک  -2

 .یک ِؽتغ تا گٛنٗ ٘ای تٛؼفتٗ ایداظ کٕيع کٗ ؼٔگ آْ تغييؽ کٕع Shape Tweenتااقتفاظٖ اؾ  -3

 .ایداظ کٕيع Buttonتؽگهتٗ ٚ یک قّثً اؾ ٔٛع تٗ  -4

 .یک ِؽتغ تٗ ِإٔع ِؽتغ أيّيهٓ قاضتٗ نعٖ ایداظ کٕيع Upظؼ فؽیُ  -5

 .أيّيهٓ قاضتٗ نعٖ ؼا لؽاؼ ظ٘يع  Overظؼ فؽیُ -6     

 (فؽیُ ٘ا کٍيعی أع.)ؼالؽاؼ ظ٘يع  upٔيؿ کپی فؽیُ  down   ٚHitظؼ فؽیُ ٘ای  -7    

ٔتيدٗ کاؼ ؼا ِها٘عٖ  Ctrl +Enter لؽاؼ ظاظٖ ٚ تاؾظْ کٍيع  Stageتؽگؽظیع ٚ ظکّٗ قاضتٗ نعٖ ؼا ظؼ  تٗ  -8     
 .کٕيع

 :يً ٌاتُزيغ حرَف رَی لا
 تٛؾیغ زؽٚف ؼٚی لایٗ ٘ای خعاگأٗ ایٓ اِکاْ ؼاتٗ نّا ِيع٘ع تا تؽای .فایعٖ ایٓ کاؼ،ِتسؽک کؽظْ زؽٚف یک کٍّٗ یاخٍّٗ اقت

 .ایم ٘ؽیک اؾ زؽٚف ،اؾ ؾِأثٕعی ٚیا أيّيهٓ ِتفاٚتی اقتفاظٖ کٕيعُٔ

زؽٚف ؼااؾُ٘ خعا Modify>Break Apart(Ctrl+B)ِكيؽ تؽای اقتفاظٖ اؾ ایٓ لاتٍيت ،اتتعا یک کٍّٗ ؼٚی يفسٗ ٔٛنتٗ ٚتاؼفتٓ تٗ
ؼااخؽاکٕيع تا زؽٚف ظؼ لایٗ ٘ای ِدؿالؽاؼگؽفتٗ ٚٔاَ لایٗ  Timelineاؾؾیؽِٕٛی  Distribute to Layersٚ ظقتٛؼ Modifyٚقپف اؾِٕٛی 

 .٘ا ،ُ٘ ٔاَ زؽف ظؼْٚ آٔٙاِی نٛظ

Import: 

تؽای .تٛاْ تٗ ِسيظ فٍم ٚاؼظ کؽظ ٚظؼقاضت أيّيهٓ ِٛؼظ اقتفاظٖ لؽاؼظاظتًاٚیؽ،يعا٘ا ٚفيٍُ ٘ایی تافؽِت ٘ای گٛٔاگْٛ ؼا ِی
ؼاظاؼیُ کٗ ظقتٛؼ اٚي ِكتميّا فایً ؼا تٗ ِسيظ أيّيهٓ اضافٗ  Import to Stage    ٚImport to Libraryگؿیٕٗ  Fileایٕکاؼ اؾِٕٛی 

 .اؾ تٛظ ِٛؼظ اقتفاظٖ لؽاؼظ٘يُِيکٕع ٚ ظقتٛؼظَٚ فایً ؼاتٗ پًٕ کتاتطأٗ اضافٗ ِيکٕع تا٘ؽؾِاْ کٗ ٔی

 :َارد کردن ػکص -الف

تًاٚیؽ تؽظاؼی زدُ کّتؽی ٔكثت تٗ تًاٚیؽٔمغٗ ای ظاؼٔع ٚتاتغييؽقایؿ ،کيفيتهاْ .(JPG)یا ٔمغٗ ای (WMF)تًاٚیؽیاتؽظاؼی أع
ؼای تفکيک آْ ِإٔعِتْٛ ػًّ اگؽتًٛیؽاضافٗ نعٖ تؽظاؼی تٛظ ب. تؽای ٚیؽایم تًٛیؽ ٔياؾظاؼیُ آٔٙاؼاتفکيک کٕيُ  .تغييؽّٔيکٕع

 Traceظقتٛؼ Modifyاِا اگؽتًٛیؽٔمغٗ ای تانع اؾِٕٛی .  (Ctrl+B)ِيکٕيُ
Bitmapؼااخؽاِيکٕيُ تالاب تٕظيّات آْ ظا٘ؽ نٛظ. 

Color Threshold:تؼييٓ زعاکثؽتفاٚت ظٚؼٔگ ِداٚؼ 

Minimum Area : تؼييٓ أعاؾٖ کٛچکتؽیٓ ٔازيٗ ؼٔگی تٌٛيعی 

Curve Fit :ٔسٖٛ تثعیً ِٕسٕی  تٕظی َ

Corner Threshold :تٕظيُ گٛنٗ ٘ای تًٛیؽ 

 .ٔٙایی تيهتؽ ضٛا٘ع نع  SWFٔکتٗ ایٕکٗ ٘ؽچٗ ِماظیؽ اٚي ٚظَٚ کّتؽ تانٕع کيفيت تًٛیؽ تٙتؽضٛا٘ع تٛظ اِا زدُ فایً 

 :Flashصذادر  َاردکردن -ب 

تؽای اقتفاظٖ اؾ يعا اتتعا تایع .پهتيثأی ِيکٕعWAV،MP3،AU،AIF،AIFF  ٚASNDاؾلاٌة ٘ای يٛتی  CS4ٔؽَ افؿاؼ فٍم ٔكطٗ 
 . ؼا تٗ کتاتطأٗ اضافٗ کؽظ ٚقپف ظؼ فؽیُ ِٛؼظ ٔظؽ لؽاؼ ظاظْآ

 

 :آغىايی تا خصُصيات صذاٌا

 .ٚاؼظ پٕدؽٖ تٕظيّات يعا ِيهٛیPropertiesُتاؼاقت کٍيک کؽظْ تؽؼٚی فایً يٛتی ٚأتطاب 
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یً يٛتی کٗ ؼٚل فهؽظٖ قاؾی فا Compressionگؿیٕٗ 
 :ؼاتؼييٓ ِيکٕع ناًِ گؿیٕٗ ٘ای ؾیؽ ِيثانع

- ADPCM: ٚاِکاْ تثعیً اقتؽیٛتٗ ِٛٔٛؼاایداظ ِيکٕع
 .ِٕاقة اقت Eventتؽای يٛت ٘ای کٛتاٖ ظؼزاٌت 

- MP3: تؽای يٛت ٘ایStreaming   ِٕاقة اقت
ٚاِکاْ تثعیً اقتؽیٛتٗ ِٛٔٛ ؼا ٔعاؼظ ٚایٕکٗ فهؽظٖ قاؾی 

 .ؾیاظی ایداظ ِيکٕع
- RAW  :ِکاْ تثعیً اقتؽیٛتٗ ِٛٔٛ ظاؼظ اِا تعْٚ ا

 .فهؽظٖ قاؾی
- Speech  : ؼٚل فهؽظٖ قاؾی کٗ تؽای يعای

 .أكاْ ِٕاقة اقت ٚاِکاْ تثعیً اقتؽیٛتٗ ِٛٔٛ ٚخٛظ ٔعاؼظ

 :اوُاع جيُي ٌای صُتی

ِيتٛاْ تٗ آْ  Propertiesپف اؾ أتطاب فایً يٛتی ظؼ پٕدؽٖ 

لاتً ظقتؽـ ِی   Effectخٍٖٛ ُ٘ اضافٗ کؽظ کٗ اؾ تطم 
ٔکتٗ ایٕکٗ قفاؼنی کؽظْ فمظ ؼٚی يٛت فؽیُ . تانع

 .کٍيعی اػّاي ِی نٛظ

 

 

 

 

 

 

 :تىظيمات ٌماٌىگ ضازی صذا

 :يعا چٙاؼتٕظيُ ٚخٛظ ظاؼظ  Synchronizeتؽای 

- Event : ّٗتؽای يعا٘ای کٛتاٖ ِإٔع کٍيک ِٛـ یا فهؽظْ ظک
قؼی نٛظ کٗ اؾ .نٛظٚيعا تایع لثً اؾ پطم کاًِ تاؼگػاؼی .ِٕاقة اقت 

يعا٘ای عٛلأی ظؼایٓ تطم اقتفاظٖ ٔهٛظ ؾیؽا تّاَ نعْ یأهعْ أيّيهٓ 
 .اظاِٗ ظاؼظؼتغی تٗ پطم يعأعاؼظ ٚپطم آْ تاأتٙای لغؼٗ يٛتی 

- Start : َپطم يعاؼا تاأتٙای أيّيهٓ اظاِٗ ِيع٘ع ٚظؼيٛؼت تّا
 .نعْ أيّيهٓ،اؾاظاِٗ پطم يعا خٍٛگيؽی ِيکٕع

- Stop :زاٌت تٗ ٚقيٍٗ فؽیُ ٘ای کٍيعی ِيتٛاْ يٛت ؼاظؼزاي ظؼای ْ
پطم کٕتؽي کؽظ تٗ ایٓ يٛؼت کٗ ظؼکٕاؼیک فؽیُ کٍيعی لؽاؼ ِيگيؽظ ٚپطم 

 .يعای فؼٍی ؼا ِتٛلف ِيکٕع
- Stream : ظؼایٓ زاٌت ،ّٔایم أيّيهٓ ٔكثت تٗ يعا تؽتؽی ظاؼظ ٚ تایک فؽیُ .يعاؼاٍِؿَ تٗ ّ٘گاِی تاضظ ؾِاْ ِيکٕع

 .ظيُ ِی نٛظ ٚتٗ أعاؾٖ فؽیُ ٘ایی کٗ أيّيهٓ انغاي کؽظٖ اقت ، پطم ِی نٛظکٍيعی تٓ

  :تکرار صذا

 :اقتفاظٖ ِيکٕيُ کٗ ظاؼای ظٚزاٌت ِی تانع  Repeatتؽای تکؽاؼيعا،اؾتطم 

1- Repeat :تاتغييؽ ػعظخٍٛی آْ ِيتٛاْ تؼعاظ تکؽاؼپطم يعا ؼاتؼييٓ کؽظ.

 
2- Loop :ب نعٖ پيٛقتٗ ظؼ زاي اخؽاضٛا٘ع تاأتطاب ایٓ گؿیٕٗ ، يٛت أتطا

 .تٛظ

 :افسَدن صذا تً دکمً

 :کاؼچٕعأی ٔعاؼظ تٕٙا کافيكت يعا ؼا ظؼ فؽیُ ِٛؼظ ٔظؽ ظؼگ کٕيُ ، فمظ ایٕکٗ 

 .ؼاأتطاب ِيکٕيُ  Downفؽیُ  Timelineاگؽ تطٛا٘يُ تاکٍيک ؼٚی ظکّٗ يعا پطم نٛظ ،ظؼ تطم -

 .ؼاأتطاب ِيکٕيُ  Overاؼِيع٘يُ ،يعا پطم نٛظ ، فؽیُ اگؽ تطٛا٘يُ ؾِأيکٗ ِاٚـ ؼاؼٚی ظکّٗ لؽ -

 .ؼاأتطاب ِيکٕيُ  Upاگؽ تطٛا٘يُ ؾِأيکٗ ظکّٗ ؼا ؼ٘ا ِيکٕيُ، يعا پطم نٛظ ،فؽیُ  -
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 : َارد کردن فييم -ج

ایً ٘ایی فمظ اؾ فCS4ٔکتٗ ای کٗ تایع ظؼٔظؽ تگيؽیع ایٓ اقت کٗ ٔكطٗ .ؼاأتطاب ِيکٕيُ  Import videoگؿیٕٗ Fileاؾِٕٛی 
زّایت ِيکٕع اگؽ پكٛٔعفایً اؾٔٛع ظیگؽی اقت ِيتٛاْ پف اؾ ایٓ ِؽزٍٗ اؾپٕدؽٖ ای کٗ تاؾ ِيهٛظ گؿیٕٗ  FLVتاپكٛٔع 

 .آٔؽا أتطاب کؽظ  Browsتثعیً ٚقپف اؾ لكّت  FLVاتتعا فایً ؼاتٗ  

Export: 

غضيؽٖ کٕيع قپف  Flaْ ،آٔؽاتاپكٛٔعپف اؾقاضت أيّيم.ِيثانع SWFضؽٚخی ٘ای فٍم ناًِ فيٍُ ،ػکف ،يفسٗ ٚب ٚ
. قؽتؽگ اقت3پٕدؽٖ ای تاؾِيهٛظکٗ ناًِ .ؼاأتطاب کٕيع  Publish Settingگؿیٕٗ Fileاؾِٕٛی 

 

 

 

 

ناًِ ٘فت ٔٛع ضؽٚخی اقت کٗ تاتيک ؾظْ ٔاَ ٘ؽیک  Formatsقؽتؽگ 
ٔاَ پيم فؽٌ فایً ٘ا ،ّ٘اْ ٔاَ أتطاب  .،ؾتأٗ تٕظيّات آْ فؼاي ِيهٛظ

 .انعنعٖ ِية

 

 

 JPEGتازؽکت ظاظْ ؾتأٗ . ناًِ چٕعگؿیٕٗ ُِٙ ِيثانعFlashقؽتؽگ  
Quality  ِيتٛاْ کيفيت ّٔایم تًاٚیؽٔمغٗ ای اقتفاظٖ نعٖ ظؼ فایً ؼا

ظؼتطم ٘ای   Setتااقتفاظٖ اؾ گؿیٕٗ (. کيفيت کُ ،زدُ کُ)تغييؽ ظاظ
Audio Stream /Event  ِٗيتٛاْ کيفيت ٚٔؽش تيت يعای تٗ کاؼؼفت

ٔيؿ  dvancedظؼتطم .فایً ؼا تغييؽ ظاظ ٚزدُ ٔٙایی کاؼؼاتغييؽ ظاظظؼ
فؼاي  Passwordتطم  Protect from Importتاتيک ظاؼکؽظْ گؿیٕٗ 

 .تااقتفاظٖ اؾ آْ ِيتٛاْ تؽؼٚی فایً ،ؼِؿ گػانتِيهٛظ کٗ 

 

 

 

 

اِکاْ تثعیً فایً فٍم تٗ یک يفسٗ ٚب تاپكٛٔع  HTMLظؼقؽتؽگ 
html یكت ظؼ ي.فؽاُ٘ ِيهٛظDimensions  ٕٗتاأتطاب یکی اؾ گؿی
ِيتٛاْ اتؼاظ ّٔایم أيّيهٓ ظؼ يفسٗ ٚب  Percentیا   Pixel٘ای 

تيک ظاؼ تانع  Loopاگؽ  Playbackظؼلكّت .ؼاتٕاتٗ ٔياؾتٕظيُ کؽظ
ٔيؿ ٕ٘گاَ  Display menu.أيّيهٓ تٗ يٛؼت ِتٛاٌی تکؽاؼ ِيهٛظ 

فایً ٔهاْ  ؼاقت کٍيک کؽظْ تؽؼٚی يفسٗ تاػث ِی نٛظ کٗ
. ظاظٖ ٔهٛظ

ؼاٖ ظیگؽ تؽای ضؽٚخی گؽفتٓ اؾ فایً ٘ای فٍم ،ؼفتٓ تٗ ِكيؽ 
File> Export  قپف ظؼپٕدؽٖ تاؾ نعٖ فؽِت ضؽٚخی ؼااؾ .ِيثانع

. أتطاب ِيکٕيُ :Save Asتطم 
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 :Action Scriptتُاوايی تکارگيری 

. ػًّ ٘ای کاؼتؽتؽؼٚی يفسٗ ٚاکٕم ظ٘ع ٔياؾ تٗ تؽٔاِٗ ٔٛیكی ظاؼظ أيّيهٓ ٘ایی کٗ تاکاؼتؽتؼاًِ تؽلؽاؼکؽظٖ ٚتٗ  تؽای ایداظ
ٚخٛظ ظاؼٔع اِا تؽای ... ٘ؽچٕع کٗ ظؼکتاتطأٗ قّثً ٘ای آِاظٖ فٍم ،گؿیٕٗ ٘ای پؽکاؼتؽظی چْٛ ظکّٗ ٘ای کٕتؽٌی پطم ٚ

 .تؽٔاِٗ ٔٛیكی فٍم ظاؼیُاؾقاضت تؽٔاِٗ ٘ای کاؼتؽظی یا تاؾی ٔياؾ تٗ آگا٘ی  

Action Script   ٗؾتاْ تؽٔاِٗ ٔٛیكی اقت ک
اخاؾٖ ایداظ تؼاًِ ،کٕتؽي ،پطم ّٚٔایم ظاظٖ ٘ا تٗ 

 .تؽٔاِٗ کاؼتؽظی ایداظنعٖ ،ِيع٘ع

تٗ ِدّٛػٗ کع٘ایی کٗ ظؼظاضً یک  اسکزیپت
فایً ِتٕی لؽاؼگؽفتٗ ٚلاتٍيت اخؽا ظاؼظ ،گفتٗ 

 .ِيهٛظ

ِكيؽ ؼفتٓ تٗ پًٕ اقکؽیپت ٔٛیكی ،أتطاب 
یااقتفاظٖ اؾ   Windowٔٛی اؾَ Actionsؾیؽِٕٛی 

 .ِيثانع F9کٍيع

 (Toolbox)اؾ نکً کٕاؼ ، خؼثٗ اتؿاؼ 3،4ٚ5ِدّٛػٗ 
 .ؼاتهکيً ِيع٘ع

 

 :لثً اؾ نؽٚع تٗ کعٔٛیكی اکهٓ لاؾَ ِيثيُٕ تٛضيساتی ظؼِٛؼظ ایٓ ؾتاْ تؽٔاِٗ ٔٛیكی تگُ 

 .ظاؼای لاتٍيت نی گؽایی اقت اقت ِٚإٔع ایٓ ظٚؾتاْ #Cِإٔع خاٚا ٚ  ايه زتان  (Syntax)گرامر  :اٚي  

 :ات اضتفادي غذي پيرامُن ايه زتانتؼريف: ظَٚ 

- Programs :یاتؽٔاِٗ ، ِدّٛػٗ ای اؾظقتٛؼاٌؼًّ ٘ا اقت  کٗ تٛقظ ٔؽَ افؿاؼ اخؽا ِی نٛظ. 
- Source Code :ظقتٛؼاتی کٗ تٛقظ تؽٔاِٗ ٔٛیف ٔٛنتٗ  ِی نٛظ. 
- Object( نی:)ظکّٗ ٘ا ،کاظؼ٘ای )ْٚ فٍم ؼا گٛیٕع کٗ ِيتٛإٔع تٗ يٛؼت تؼاٍِی ظؼایٓ ؾتاْ تؽٔاِٗ ٔٛیكی ،انيا ظؼ

 .تانٕع( انکاي)یاغيؽتؼاٍِی ( ِتٕی ٚاؾایٓ لثيً
- Class(کلاـ :) ( ٚیژگی، ِتع ٚؼٚیعاظ)ِهطًٗ ايٍی 3گؽٚ٘ی اؾانيا کٗ ٚیژگی ٘ای ِهتؽکی ظانتٗ ٚظاؼای

   Sprite,Video,Timer,Date MovieClip:ػثاؼتٕع اؾ   Action Scriptکلاـ ٘ای .ِيثانٕع
- Properties( ضاييت :) ِهطًٗ ٘ایی تؽای تؼييٓ ٚیژگی ٘ای انيا ِإٔع عٛي ، ػؽٌ ،ؼٔگ 
- Methods(ِتع٘ا : )ػٍّياتی کٗ تٗ يٛؼت تاتغ ٔٛنتٗ ِی نٛٔع ٚتؽای کٕتؽي انيا تٗ کاؼِيؽٚٔع. 
- Events (ؼٚیعاظ٘ا :)إٔع ظاتً کٍيکَ.ٚلایؼی کٗ نی ِيتٛأع ٔكثت تٗ آٔٙا ٚاکٕم ٔهاْ ظ٘ع 
- Variables  (ِتغيؽ٘ا:)تؽای قاضت یک ِتغيؽ ٔياؾتٗ اقُ .خؼثٗ ٘ایی ٘كتٕع تؽای غضيؽٖ ظاظٖ ٘ا ٚاعلاػات ِؽتٛط تٗ آٔٙا

 :ِٕسًؽتٗ فؽظ ٚ یک ِمعاؼٚتؼييٓ ٔٛع ظاظٖ آْ ظاؼیُ 
Var myVariable: Number=1; (اػلاْ ِتغيؽ) 

 تٛضير ٔٛع ظاظٖ

Number ٘ؽػعظی 

int ذ٘ؽػعظيسی 

unit اػعاظيسير تعْٚ ػلاِت 

String ِتٓ یاؼنتٗ ای اؾکاؼاکتؽ 

Boolean ِماظیؽ ظِٚمعاؼی 

Array (آؼایٗ)تيم اؾیک ِمعاؼ ظؼیک ِتغيؽ 

Object یک قاضتاؼپایٗ تؽای ٘ؽٚازع 

 :ٔکاتی کٗ لاؾَ اقت ٕ٘گاَ تؼييٓ ٔاَ یک ِتغيؽ ِع ٔظؽلؽاؼ ظ٘يُ

 .ِت ظلاؼ نؽٚع نٛظٔاَ ِتغيؽ تایع تا زؽٚف ،ؾیؽضظ یا ػلا .1
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 .ٔاَ ِتغيؽ ػلاٖٚ تؽِٛاؼظ تالا ِيتٛأع ناًِ اػعاظ ٔيؿ تانع .2
 .اؾکاؼاکتؽ فايٍٗ ظؼٔاَ ِتغيؽ ّٔيتٛاْ اقتفاظٖ کؽظ .3
 .اؾکٍّات ؼؾؼٚ نعٖ  ّٔيتٛاْ تٗ ػٕٛاْ ٔاَ ِتغيؽ اقتفاظٖ کؽظ .4
 .ظٖ کٕيُاگؽاؾزؽٚف ظؼ نؽٚع ٔاَ ِتغيؽ اقتفاظٖ ِيکٕيُ ، لاؾَ اقت اؾ زؽٚف کٛچک اقتفا .5

 
 ِإٔع اقاِی ٚاػعاظ.ِهطًٗ ٘ایی ٘كتٕع کٗ ظؼعٛي تؽٔاِٗ تغييؽ ّٔيکٕٕع: ثاتت ٘ا -

 آغىايی مختصر تاتؼضی ضاختارٌای پرکارترد: قَٛ 

اؾ قاضتاؼ٘ای تؼضی تٛاتغ ؼٚایٕدا ِيگُ نّا تؽای ظٚٔكتٓ تيهتؽ ،کافيٗ یا (اٚٔمعؼ کٗ فکؽِيکُٕ لاؾِٗ ) تٛضير ایٕکٗ ،ِٓ کّی 
ٚظ ٔؽَ افؿاؼیاتؽؼقی ِهاتٗ ایٓ تٛاتغ ظؼؾتاْ ٘ای تؽٔاِٗ ٔٛیكی ظیگؽ ٚتكت آٔٙا ظؼ ایٓ ؾتاْ ، تاظقتٛؼات ٚقاضتاؼ٘ای ش Helpاؾ 

 .ظیگؽ آنٕانٛیع

ظؼقت تانع ،یک ِدّٛػٗ ظقتٛؼاتی اخؽا ِيهٛظ ٚاگؽ ٔاظؼقت تانع  ifاگؽػثاؼت نؽعی خٍٛ :If … Elseساختار  -
 .اخؽا ِيهٛظ Else ِدّٛػٗ ظقتٛؼات تؼييٓ نعٖ تؽای ػثاؼت

اگؽتطٛا٘يُ نؽط تٗ اؾای ِماظیؽ ِطتٍف ِٛؼظ تؽؼقی لؽاؼ گؽفتٗ ٚگؽٚ٘ی اؾِدّٛػٗ :Switch … caseساختار -
 Caseتا ٘ؽکعاَ اؾِماظیؽخٍٛی  Switchاگؽِتغيؽ خٍٛی .ظقتٛؼات اخؽانٛٔع،اؾایٓ قاضتاؼنؽعی اقتفاظٖ ِيکٕيُ

ضاتّٗ ِی یاتع ٚاگؽ ایٓ ِتغيؽ تا٘يچيک  Switchخؽانعٖ ٚفؽِاْ ا Caseتؽاتؽتانع ،ِدّٛػٗ ظقتٛؼات ِؽتٛط تٗ ّ٘اْ 
تؽای تكتٓ یک فؽِاْ زٍمٗ ظؼزاي اخؽا ِٛؼظ اقتفاظٖ  breakکٍّٗ .اخؽا ِی نٛظ  Defaultاؾِماظیؽ تؽاتؽ ٔثانع،ظقتٛؼ

 .لؽاؼ ِيگيؽظ
ظٖ ِيهٛظ کٗ تؼعاظ ٚظؼِٛاؼظی اقتفا.ایٓ قاضتاؼتؽای نّاؼل تيهتؽ اقتفاظٖ ِيهٛظ :forحلقه تکزار شوارشی  -

 قاضتاؼ آْ تٗ يٛؼت . ظفؼات تکؽاؼ ِهطى تانع

 
 .ِيثانع کٗ لاؾَ اقت ِمعاؼ نّاؼٔعٖ اؾلثً تؼؽیف نعٖ تانع

ظؼایٓ ٔٛع قاضتاؼ ،تکؽاؼ زٍمٗ تؽاقاـ تؼعاظ ٚیژگی نی ء ِهطى نعٖ أداَ : for inحلقه تکزار شوارشی  -
 .ضٛا٘عگؽفت

نؽط زٍمٗ تؽؼقی نعٖ ٚظؼيٛؼت ظؼقت تٛظْ نؽط ، زٍمٗ تکؽاؼ ضٛا٘ع  ظؼایٓ قاضتاؼ،اتتعا: whileحلقه شزطی  -
 .نع

ظؼ ایٓ قاضتاؼ ،اتتعا ظقتٛؼات اخؽانعٖ ٚقپف نؽط تؽؼقی ِيهٛظ ٚظؼيٛؼت ظؼقت : do … whileساختار حلقه  -
تٛظْ نؽط ، زٍمٗ 

ِدعظا تکؽاؼ 
 .ِيهٛظ

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 :آغىايی تا تؼضی متذٌا َدضتُرات: چٙاؼَ 

 
 .اقتفاظٖ ّٔایيع  ;ٔکتٗ لاتً غکؽایٕکٗ ظؼپایاْ ٘ؽظقتٛؼاؾ.ؼات ظؼایٓ ؾتاْ تؽٔاِٗ ٔٛیكی ،چٕعاْ ظنٛاؼ ٔيكت ظقتٛ

اقتفاظٖ /* */ تؽای تٛضيسات چٕعضغی اؾ .اقتفاظٖ کٕيع //اگؽ تطٛا٘يع ظقتٛؼی ؼا غيؽ فؼاي کٕيع ِيتٛأيع ظؼاتتعای ظقتٛؼ اؾ 
 .تؽای پایاْ تٛضيسات تکاؼ ِيؽٚظ/* تؽای نؽٚع تٛضير ٚ */ ِيهٛظ تغٛؼیکٗ 

 Actionظؼ کٛچک ٚتؿؼگ ٔٛنتٓ زؽٚف ظلت کٕيع ؾیؽا .اقتفاظٖ ٔکٕيع...( ٚ  trace ،ifِإٔع )ظؼٔاِگػاؼی ٘ا اؾ کٍّات ؼؾؼٚ نعٖ 
Script ثاتت ٘ا ٚٔاَ ؼٚیعاظ ٘ا ؼاتازؽٚف.ٔاَ کلاـ ٘ا ّ٘يهٗ تا زؽٚف تؿؼگ نؽٚع ِيهٛظ .تٗ زؽٚف تؿؼگ ٚکٛچک زكاـ اقت 

 .تؿؼگ تٕٛیكيع
ٔکتٗ ظیگؽایٕکٗ ظؼؾِاْ کعٔٛیكی ،تدای فؽیُ ِٛؼظ ٔظؽ ِيتٛاْ تؽچكة فؽیُ ؼاظؼظقتٛؼات ٚاؼظ کؽظ کٗ تاػث ِيهٛظ ظؼيٛؼت 

٘ؽقّثً  Propertiesتؽچكة ظؼ لكّت .تؽاقاـ تؽچكة ظاظٖ نعٖ ظقتٛؼات ؼإِظٛؼکٕع Action Scriptاػّاي تغييؽات،
 .ِيثانع

- stop()  :ًظؼ فؽیُ کٍيعی خاؼی تکاؼِيؽٚظ ٚآؼگِٛاْ ٚؼٚظی ٔعاؼظتؽای تٛلف في َ. 
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- gotoAndStop() : ظاضً پؽأتؿ نّاؼٖ .تؽای أتماي ٘عپطم ظؼفؽیُ ِهطى نع٘ٛ ّ٘چٕيٓ تٛلف ظؼآْ فؽیُ ِيثانع
 .ٔٛنتٗ ِی نٛظ،(ظاضً کٛتيهٓ )تؽچكة فؽیُ  یا فؽیُ

- gotoAndPlay()  :ظاضً .یکٗ پطم فيٍُ اؾآْ فؽیُ اظاِٗ ِی یاتع تؽای أتماي ٘ع پطم ظؼفؽیُ ِهطى نعٖ تٗ عٛؼ
 .ٔٛنتٗ ِيهٛظ،(ظاضً کٛتيهٓ )یا تؽچكة فؽیُ پؽأتؿ نّاؼٖ فؽیُ 

- nextFrame()  :تؽای أتماي تٗ فؽیُ تؼعی اقت ٚآؼگِٛاْ ٚؼٚظی ٔعاؼظ. 
- prevFrame() :تؽای أتماي تٗ فؽیُ لثٍی تٛظٖ ٚآؼگِٛاْ ٚؼٚظی ٔعاؼظ. 
- Play() :َ ٍُٚؼظ اقتفاظٖ لؽاؼ ِيگيؽظتؽای پطم في. 
 ,MOUSE_DOWN,MOUSE_UP,MOUSE_MOVE,MOUSE_OVER,CLICK,DOUBLE_CLICK: ِٛـ ؼٚیعاظ ٘ای  -
 KEY_DOWN,KEY_UP:يفسٗ کٍيع ؼٚیعاظ٘ای -
- .visible= falseَِطفی کؽظْ نی : نی  ٔا 
- stageWidth,stageHeight  : ٚیژگی ٘ایStage  ِٛ ٕٗؼظ اقتفاظٖ لؽاؼ ِيگيؽٔعکٗ ظؼؾِاْ لؽاؼ ظاظْ یک نی ظؼ يس. 
- getURL(url,window,method)  :ایٓ ظقتٛؼ،ِٕدؽتٗ أتماي ِطاعة تٗ یک يفسٗ ٚب ظیگؽ ِيهٛظ. 
- 0xRRGGBB  =.color  ٓتؽای تؼييٓ ؼٔگ ِتٓ کٗ : نی ِتRR  ،ِمعاؼؼٔگ لؽِؿGG   ِٚمعاؼ ؼٔگ قثؿBB   ِمعاؼ ؼٔگ آتی

 .ؼا تؼييٓ ِيکٕٕع

 رآغىايی تا جؼثً اتسا: پىجم 

 

 

 

 

 

 

 

 

 

 

 :نؽٚع تٗ کاؼ

 :تؽای نؽٚع ،ِثاي قاظٖ ای ؼاأداَ ِيع٘يُ 

عؽازی کٕيع کٗ یک قّت يفسٗ تٗ قّت ظیگؽ  Shape Tweenفایً خعیعی تاؾ کٕيع ٚ ظؼ لایٗ اٚي ، أيّيهٕی ؼا تااقتفاظٖ اؾ 
یٗ یک فؽیُ لایٗ ظیگؽی ؼا اضافٗ کٕيع ٚ ِتٕاقة تافؽیُ آضؽ أيّيهٓ ،ظؼفؽیُ ایٓ لا. زؽکت کٕع

یااؾِكيؽ   F9تافهؽظْ کٍيع )ِسيظ کعٔٛیكی اکهٓ اقپؽیت ؼاتاؾ کٕيع . کٍيعی ضاٌی ایداظ کٕيع 
Window > Actions )تاتغ ٚstop()    زاي تااخؽای فایً ، أيّيهٓ اؾ یک قّت يفسٗ .ؼايعاتؿٔيع

 .تٗ قّت ظیگؽ زؽکت ِيکٕع ٚظؼأتٙای اخؽا ِتٛلف ِيهٛظ 

اضافٗ  Timelineتٗ فؽیُ ِٛؼظ ٔظؽ ظؼ αظؼفؽیُ کٍيعی ، زؽف  Action Scriptظتؼعاؾٔٛنتٓ ک :ًکته .ِيهٛظ

عٛؼی تاؼظیگؽ .ِتٛلف نٛظ 15أيّيهٓ تالا ؼاعٛؼی تغييؽ ظ٘يع کٗ اتتعافيٍُ تاآضؽیٓ فؽیُ پطم نعٖ ٚقپف ظؼفؽیُ  :توزیي
 .٘ا پطم نٛظتاأت 15فيٍُ تاآضؽیٓ فؽیُ پطم نٛظ ٚظؼظفؼات تؼعی اؾ فؽیُ تغييؽظ٘يع کٗ 

تؽای ظقتؽقی تٗ ِهطًات انيا ٚ تغييؽٚیژگی ٘ای آٔٙا یا اػّاي تٛاتغ تؽؼٚی آٔٙا ،ٔياؾ تٗ : اضتفادي از غی درتروامً وُيطی 

 propertiesظؼِسيظ تؽٔاِٗ ،اؾلكّت ( قّثً ،نکً )تؽای ایٕکاؼ تٕٙاکافيكت پف اؾاقتفاظٖ اؾ نی .تؼؽیف ٔاَ تؽای نی ظاؼیُ 
ؼاأتطاب ٚقپف العاَ تٗ   Object Drawingٔکتٗ ظیگؽ ایٕکٗ ،ٕ٘گاَ تؽقيُ یک نکً زتّا آیکٓ .ؼٔظؽ تگيؽیُتؽای آْ یک ٔاَ ظ

 .تؽقيُ ّٔایيع

اگؽظؼپؽأتؿ . ضؽٚخی آؼگِٛاْ ٘ای ایٓ تاتغ تؽؼٚی پًٕ ضؽٚخی ظؼؾِاْ ّٔایم فيٍُ ٔٙایی چاپ ِيهٛظ: ()traceتاتغ کارتردی 

اگؽ خٍّٗ ِساقثاتی ػعظی ٚاؼظ کٕيع ،ٔتيدٗ خٍّٗ ظؼ ضؽٚخی . ؼٚخی ّٔایم ظاظٖ ِيهٛظایٓ تاتغ ،ػعظ ٚاؼظ کٕيع ،ػعظ ظؼ ش
تؽای ّٔایم ػثاؼت ؼنتٗ ای ظؼضؽٚخی کافيكت ػثاؼت  ؼا ظاضً کٛتيهٓ لؽاؼ ظ٘يُ ٚظؼآضؽ ایٕکٗ تؽای .ّٔایم ظاظٖ ِيهٛظ 

  .اقتفاظٖ کٕيُ ,ّٔایم تيم اؾیک پاؼاِتؽ ،ِيتٛأيُ اؾ 
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 : Action Scriptػميگرٌا در 

 .کٗ ظاؼای ضؽٚخی ػعظی أع(  -، + ، % ، / ، )* ػٍّگؽ٘ای ؼیاضی  -
 .أع  falseیا   trueکٗ ظاؼای ضؽٚخی =!( ، = >، = <، == ، > ، < )ػٍّگؽ٘ای ِمایكٗ ای  -
 .کٗ ظاؼای ضؽٚخی ػؼعی أع=*( ، =/ ، =% ، =+ ،  =-، )= ػٍّگؽ٘ای أتكاب  -

 .أع  falseیا   trueظاؼای ضؽٚخی  کٗ( &&، || )ػٍّگؽ٘ای ِٕغمی  -
 .کٗ ظاؼای ضؽٚخی ؼنتٗ اقت) + ( ػٍّگؽ اٌساق ؼنتٗ  -

نی خعیعی تٗ ٔاَ   Action Scriptظاؼیُ ِٚيطٛا٘يُ ظؼ   fmتأاَ ّٔٛٔٗ    Movie Clipفؽٌ کٕيع نی ای اؾٔٛع  :متغير غی ء

obj1  اؾٔٛعfm  ُتفاظٖ ِيکٕيُ تؽای تؼؽیف ِتغيؽ نی اؾ ظقتٛؼ ؾیؽ اـ. تؼؽیف کٕي      : 

 Varٔاَ ِتغيؽ نی ء : ٔاَ کلاـ = ٔاَ نی ;      

Var obj1:MovieClip=fm; 

تاتغ ، ِدّٛػٗ ای اؾکع٘ا تؽای ٚظایف ضاو ٘كتٕع کٗ تؽای اقتفاظٖ ِدعظ ظؼ تؽٔاِٗ تٗ کاؼِيؽٚٔع : تؼريف َفراخُاوی تاتغ

ِتغيؽ٘اتاٚاؼظکؽظْ ِماظیؽٚؼٚظی تٗ تعٔٗ تاتغ ، تاػث ایداظ یک ٘ؽتاتغ اؾیک ٔاَ ٚتؼعای ِتغيؽٚؼٚظی تهکيً نعٖ تٗ عٛؼیکٗ .
ظٚٔٛع تاتغ ِيتٛاْ ِٛؼظ اقتفاظٖ لؽاؼ   Action Scriptظؼ  .ضٛإ٘ع نع ٚؼٚظی  لاظیؽَضؽٚخی پف اؾأداَ یک قؽی ػٍّيات تؽؼٚی 

 :ظاظ 

 .تانع voidاگؽتاتغ ِماظیؽتاؾگهتی ٔعانتٗ تانع یا ِمعاؼ تاؾگهتی آْ :متذٌا -   

. اگؽ تاتغ ِمعاؼ تاؾگهتی ظانتٗ تانع:  تطتً ٌای تاتؼی –   

 

" ٔاَ تاتغ ( ٌيكت ٚؼٚظی ٘ا " )فؽاضٛأی تاتغ ،ظؼ ِتع٘ا تٗ يٛؼت  

ٔاَ تاتغ (ٌيكت ِتغيؽ٘ای ٚؼٚظی ")ٚظؼ تكتٗ ٘ای تاتؼی تٗ يٛؼت 
 .ِيثانع" ِتغيؽ = 

 :تؼريف تاتغ ترای کىتره اغيا 
. فسٗ ِيتٛأع ٘ؽ تاتؼی تؼؽیف کٕع اِا ظؼزيٓ تؼؽیف تایع تٗ ٔٛع تاتغ ٚ ِماظیؽ ٚؼٚظی تٛخٗ ظانتٗ تانع کاؼتؽ تؽای کٕتؽي انيا ظؼ و

 .ِٕٙعـ اتؽیهّی ؼا تٛييٗ ِيکُٕ"  Cتؽٔاِٗ ٔٛیكی "تؽای تكٍظ تيهتؽ تؽ ؼٚی ایٓ ِثسث ، ضٛأعْ کتاب 

 :تاتؼی تؽای چؽضأعْ انيا تؼؽیف کٕيع : ِثاي 

  Movie Clipظؼخٗ ٘ؽ قّثٍی اؾٔٛع  90ی چؽضأعْ اؾایٓ تاتغ ِيتٛاْ تؽا
 !!!تٗ فؽاضٛأی تاتغ ظلت کٕيع.اقتفاظٖ کؽظ

 

 

زاي تاتغ تالا ؼا تٗ ایٓ يٛؼت تؼؽیف ِيکٕيُ کٗ ػلاٖٚ 
ؼأيؿ تٗ ػٕٛاْ ٚ خٙت چؽضم   X, Yتؽ نکً ، ِماظیؽ 
اتغ ؼا ِيتٛاْ ظؼ ٘ؽفؽیُ تؽای ایٓ ت.ٚؼٚظی ظؼیافت کٕع

 .فؽاضٛأی کؽظ  Movie Clip٘ؽقّثً 
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parent  ،َ ًوقط this در فيع :this   ظؼٚالغscope   ظؼٚالغ ّ٘اْ )یا ظإِٗ ای اقت کٗ ظؼزاي کاؼتاآْ ٘كتيعtimeline 

زاي اگؽ تطٛا٘يُ تٗ یک قغر پایيٕتؽاناؼٖ کٕيُ ،اؾ ٔمغٗ اقتفاظٖ ِيکٕيُ ٚاگؽ تطٛا٘يُ تٗ یک قغر تالاتؽ اناؼٖ کٕيُ اؾ ( .خاؼی
parent تفاظٖ ِيکٕيُاـ .

 

ظاؼیُ کٗ ظؼ ظاضً آْ یک  Pencilتٗ ٔاَ  MovieClipایداظکؽظٖ ایُ کٗ ظؼظاضً آْ یک  Bagفؽٌ کٕيع یک أيّيهٓ تٗ ٔاَ : هثال
Eraser   ٚزاي ضظ فؽِاْ ظؼ .ٚخٛظ ظاؼظPencil ِيثانع. 

اؾ ٔمغٗ تٗ ػٕٛاْ خعاکٕٕعٖ نی اؾ ٚیژگی ، ُ٘ چٕيٓ 
 .فاظٖ ِی نٛظِتع،ؼٚیعاظ ٚ نی ای ظیگؽ اقت

 

 

 :کّک ِيگيؽیُ تٗ يٛؼت   varاگؽتطٛا٘يُ اؾکلاـ اقتفاظٖ کٕيُ اؾظقتٛؼ : اضتفادي ار کلاش در فيع

 var کلاـٔاَ :  کلاـ ٔٛع=  newکلاـ  ٔٛع )(

 

تؽٔاِٗ ای تٕٛیكيع کٗ ٔاَ ؼٚؾ٘فتٗ ؼاظؼضؽٚخی :تّؽیٓ 
 .ٔهاْ ظ٘ع

تسث کلاـ تسث گكتؽظٖ ای اقت ِٚثٕای نی گؽایی ظؼ 
تؽای ِغاٌؼٗ تيهتؽ ِثسث ) ؾتاْ تؽٔاِٗ ٔٛیكی ِيثانع 

OOP  ظؼ ؾتأٙای  تؽٔاِٗ ٔٛیكی نی گؽا) 

 

 

 

 

 

 

Events  (رَيذادٌا): 

یا   EventListenerتؽای ایٕکٗ ظؼ عٛي اخؽای تؽٔاِٗ تفّٙيُ چٗ ؼٚیعاظی ؼش ظاظٖ یا ِّکٓ اقت ؼش ظ٘ع ،اؾ ِفِٙٛی تست ػٕٛاْ 
فؽَ تاتؼی کٗ تؽای اضافٗ کؽظْ گٛل ظٕ٘عٖ ؼٚیعاظ ِٛؼظ اقتفاظٖ لؽاؼ ِيگيؽظ تٗ يٛؼت ؼٚتؽٚ .کٕيُگٛل ظٕ٘عٖ ؼٚیعاظ اقتفاظٖ ِی

 :اقت

 ٔاَ نی addEventListener.( ِٕثغ ؼٚیعاظ .ٔاَ ؼٚیعاظ  ,ِتع پاقص ظ٘ی تٗ ؼٚیعاظ ) ;

،قؼی کٕيع اؾ ٔاِی ِتٕاقة تا ؼٚیعاظ  ٚیعاظٕ٘گاَ أتطاب ٔاَ ؼ.تانع ... ِٕثغ ؼٚیعاظ ِيتٛأع يفسٗ کٍيع ،ِٛـ ،تایّؽ قيكتُ ٚ
 .اقتفاظٖ کٕيع ّٚ٘أغٛؼکٗ لثلا ُ٘ گفتُ ّ٘ٗ زؽٚف ٔاَ تٗ يٛؼت تؿؼگ ِيثانٕع

 .تاتؼی اقت کٗ ِهطى ِيکٕع تٗ اؾای ؼش ظاظْ ؼٚیعاظ ،چٗ ظقتٛؼاتی تایع اخؽانٛٔع :متذ پاضخ دٌی تً رَيذاد

Void ( :نی ؼٚیعاظ:ِٕثغ ؼٚیعاظ )ظاظ ِتعپاقص ظ٘ی تٗ ؼٚیfunction 

 {کع٘ایی کٗ ٕ٘گاَ ؼش ظاظْ ؼٚیعاظ تایع اخؽا نٛٔع}
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 .ِتٛلف نٛٔع  Stopنؽٚع ٚتاؾظْ ظکّٗ Startأيّيهٓ ٘ای قاضتٗ نعٖ ؼا عٛؼی تغييؽ ظ٘يع کٗ تاؾظْ ظکّٗ : ِثاي 

 :ِؽازً أداَ کاؼ

أيّيهٓ خعیعی ایداظ ٚ ظؼلایٗ اٚي  -1
تااقتفاظٖ اؾ ِيأياتی ،أيّيهٕی ایداظ 

 .یکٕيَُ

ایداظ ٚیک قّثً  Startلایٗ ظَٚ تٗ ٔاَ  -2
عؽازی ٚظؼ آْ   btStartظکّٗ ای تٗ ٔاَ 

لؽاؼ ِيع٘يُ ٚظؼفؽیُ اٚي آْ کع ؾیؽ ؼا لؽاؼ 
 .ِيع٘يُ

ایداظ ٚقّثً  Stopلایٗ قَٛ تٗ ٔاَ  -3
ؼا تؽؼٚی آْ لؽاؼ  btStopظکّٗ ای تٗ ٔاَ 

 .ؼا ظؼفؽیُ اٚي آْ ِيٕٛیكيُ ؼٚتؽٚ ظاظٖ ٚکع 

 

 Stopأيّيهٓ نؽٚع ٚتاؾظْ ظکّٗ   Startتااخؽای تؽٔاِٗ، تاؾظْ ظکّٗ  -4
 .ِتٛلف ِيهٛظ

ِهطى کؽظیُ کٗ اخؽا یا تٛلف  addEventListenerظؼکعتالا ،تااقتفاظٖ اؾ ِتع 
کٍيک   Startاگؽ تؽؼٚی ظکّٗ .فيٍُ ِٕٛط تٗ کٍيک نعْ تؽؼٚی ظکّٗ اقت 

 .اخؽا ِيهٛظ pauseMovieکٍيک نٛظ تاتغ  Stopاخؽا ٚاگؽ تؽؼٚی ظکّٗ  playMovieنٛظ تاتغ 

تایک .ػٕايؽ ؼٚی يفسٗ اقت ْیکی اؾکاؼ٘ای اقاقی ظؼقاضت أيّيهٓ ٘ای فٍم ،ایداظ لاتٍيت زؽکت ظاظ:حرکت دادن غکو

 .تؽؼقی ِيکٕيُؼا تٛاتغ کاؼتؽظی تؽای زؽکت قّثً ٘ا ؼٚی يفسٗ تاپایيٓ ٔگٗ ظانتٓ ِٛـ ،ِثاي 

  :ِؽازً أداَ کاؼ

ي یک قّة -1
ّٔایهی ؼٚی 

يفسٗ لؽاؼظاظٖ 
ؼاتٗ آْ  mfٚٔاَ 

 .اضتًاو ظ٘يع
یک فؽیُ کٍيعی  -2

  .ٚاؼظ ِسيظ کعٔٛیكی نٛیع F9ایداظ ٚتافهاؼظاظْ کٍيع
  .کع٘ای ؾیؽؼاٚاؼظ ٚ تاتغ ؼا اخؽاکٕيع -3

 

ظٚتاؼٖ  ّ٘أغٛؼکٗ ِها٘عٖ ِيکٕيع ،تاپایيٓ ٔگٗ ظانتٓ ِٛـ ؼٚی نکً ٚکهيعْ آْ ،نکً خاتٗ خا ِی نٛظ ٚتاکٍيک کؽظْ
. ،اؾایٓ زاٌت ضاؼج ِيهٛیُ

 :دريافت دَػذد ازکارتر َومايع حاصيضرب آن

 :ِؽازً أداَ کاؼ

ظٚلایٗ ایداظ کٕيع ،لایٗ اٚي تٗ ٔاَ ِتٓ  -1
 ٚلایٗ ظَٚ تٗ ٔاَ کع

ظؼ لایٗ اٚي تااقتفاظٖ اؾ اتؿاؼ ِتٓ  -2

ایٓ ٔٛنتٗ ٘ا اؾ .ؼاؼقُ کٕيع  ٚ 
 .٘كتٕع   Staticٔٛع 

خٍٛی ظٚٔٛنتٗ تالا ، تؽای ٚؼٚظ ظاظٖ ، ظؼ -3
 inputA ٚinputBکاظؼ٘ایی تأاَ ٘ای 

 ( .inputِتٓ اؾ ٔٛع )ایداظ کٕيع 
ایداظ  result1یک قّثً ظکّٗ ای تأاَ  -4

ٚظؼخٍٛی آْ ،کاظؼی ِتٕی اؾٔٛع ٚؼٚظی ، 
 .تؽای ّٔایم ضؽٚخی ایداظ کٕيع
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 .چک کٕيع A ٚBٚؼٚظی  ظؼفؽیُ کٍيعی لایٗ کع،کعؾیؽ ؼاٚاؼظ ٚٔتيدٗ ؼا تا ظاظْ ِمعاؼ تٗ کاظؼ٘ای -5

ِماظیؽ ؼنتٗ  Numberتااقتفاظٖ اؾتاتغ فؽاضٛأی کٗ ظؼآْ ، zarbتٗ کٍيک زكاـ  ٚتاؾظْ کٍيک تؽؼٚی آْ ،تاتغ  result1ظکّٗ 
کٗ تٗ  inputZتٗ ؼنتٗ تثعیً ٚظؼ کاظؼ   Stringای ٚؼٚظی تٗ ػعظ تثعیً ، ػٍّيات ِٛؼظ ٔظؽ أداَ ٚ ٔتيدٗ تااقتفاظٖ اؾ تاتغ 

. ایٕاِيک تؼؽیف نعٖ اقت ، لؽاؼ ِيگيؽظيٛؼت ظ

 

 :Action Scriptکىتره رمس ػثُر تُضظ  

 :ِؽازً أداَ کاؼ

 .أيّيهٕی ظؼ لایٗ اٚي ایداظ کٕيع -1

،کاظؼ ٚؼٚظ ؼِؿ اؾٔٛع ٚؼٚظی  passTxtاؾٔٛع ظایٕاِيک تأاَ ظؼ لایٗ ظَٚ ،تااقتفاظٖ اؾ اتؿاؼ ِتٓ ،کاظؼؼِؿ -2

 ٚ ظکّٗ  inputPassتأاَ 
 .ؼاایداظ کٕيع 

ظؼ لایٗ قَٛ ،ظؼ فؽیُ کٍيعی اٚي کع  -3
ؼا لؽاؼ ظ٘يع ٚٔتيدٗ ؼا ِها٘عٖ ؼٚتؽٚ
 .کٕيع

ظؼ يٛؼتی کٗ ؼِؿ ٚاؼظنعٖ  okPassتاتغ 
تانع ،کاظؼ٘ای  mfظؼ کاظؼ ٚؼٚظ تؽاتؽ 

Password   ٚ ٚؼٚظ پكٛؼظ،ok   ؼا ِطفی
ٚنؽٚع تٗ اخؽای تؽٔاِٗ ِيکٕع ٚظؼ يٛؼت 

 Wrong Try“ػثاؼت  ٚؼٚظ ؼِؿ انتثاٖ ،
again”   ؼا چاپ ِيکٕع. 

 

 

 

 

 

 

 

 : Action Scriptَرَد َخرَج کذ ٌا در محيظ 

اؾ گؿیٕٗ ٘ای  helpٚظؼتالای تطم   Action Script، ٚالغ ظؼ أتٙای يفسٗ تؽای ایٓ ِٕظٛؼ اؾ تطم پًٕ اکهٓ 

 ی گؽفتٓ اؾٚجتؽای ضؽ Exportتؽای ٚؼٚظ کع تٗ ِسيظ کعٔٛیكی ٚ  Import. کّک ِيگيؽیُ
 .کع

 



Flash Cs4 Learning  

 Page 30 آمىزشگاه اسپيرال 
 

 :وتيجً گيری
اِيع کٗ خؿٖٚ زاضؽ ،تتٛأع کّک نایأی ظؼ خٙت .گكتؽظٖ تؽ اؾ آْ اقت کٗ تتٛاْ ظؼ چٕع ظٖ يفسٗ گٕدأع  Action Scriptِثسث 

. یاظگيؽی ِثسث أيّيهٓ قاؾی ظٚ تؼعی ظانتٗ تانع

 

 

 

 

 

 

 

 

 

 

 

 

. اِيع کٗ تّاَ تلال ؾٔعگيّْٛ ؼقيعْ تٗ ؼضای اٌٙی تانٗ خٍّٗ ؾیثای ظکتؽ نؽیؼتی ؼٚ تمعیُ ِيکُٕ تٗ ّ٘ٗ ػؿیؿاْ ،

 

!! برگ در انتهای زوال میافتد و میوه در ابتدای کمال "

 "یافتیمبنگر که چگونه 

 

 

 


